
Chapter 2

Multiple Linear Regression

This chapter introduces the multiple linear regression model, the response
plot for checking goodness of fit, the residual plot for checking lack of fit,
the ANOVA F test, the partial F test, the t tests, and least squares. The
problems use software R, SAS, Minitab, and Arc.

2.1 The MLR Model

Definition 2.1. The response variable is the variable that you want to
predict. The predictor variables are the variables used to predict the re-
sponse variable.

Notation. In this text the response variable will usually be denoted by
Y and the p predictor variables will often be denoted by x1, . . . , xp. The
response variable is also called the dependent variable while the predictor
variables are also called independent variables, explanatory variables, carri-
ers, or covariates. Often the predictor variables will be collected in a vector x.
Then xT is the transpose of x.

Definition 2.2. Regression is the study of the conditional distribu-
tion Y |x of the response variable Y given the vector of predictors x =
(x1, . . . , xp)

T .

Definition 2.3. A quantitative variable takes on numerical values
while a qualitative variable takes on categorical values.

Example 2.1. Archeologists and crime scene investigators sometimes
want to predict the height of a person from partial skeletal remains. A model
for prediction can be built from nearly complete skeletons or from living
humans, depending on the population of interest (e.g., ancient Egyptians
or modern US citizens). The response variable Y is height and the predic-
tor variables might be x1 ≡ 1, x2 = femur length, and x3 = ulna length.
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18 2 Multiple Linear Regression

The heights of individuals with x2 = 200mm and x3 = 140mm should be
shorter on average than the heights of individuals with x2 = 500mm and
x3 = 350mm. In this example Y , x2, and x3 are quantitative variables. If
x4 = gender is a predictor variable, then gender (coded as male = 1 and
female = 0) is qualitative.

Definition 2.4. Suppose that the response variable Y and at least one
predictor variable xi are quantitative. Then the multiple linear regression
(MLR) model is

Yi = xi,1β1 + xi,2β2 + · · ·+ xi,pβp + ei = xT
i β + ei (2.1)

for i = 1, . . . , n. Here n is the sample size and the random variable ei is the
ith error. Suppressing the subscript i, the model is Y = xTβ + e.

In matrix notation, these n equations become

Y = Xβ + e, (2.2)

where Y is an n × 1 vector of dependent variables, X is an n × p matrix
of predictors, β is a p × 1 vector of unknown coefficients, and e is an n × 1
vector of unknown errors. Equivalently,

⎡
⎢⎢⎢⎣

Y1

Y2

...
Yn

⎤
⎥⎥⎥⎦ =

⎡
⎢⎢⎢⎣

x1,1 x1,2 . . . x1,p

x2,1 x2,2 . . . x2,p

...
...

. . .
...

xn,1 xn,2 . . . xn,p

⎤
⎥⎥⎥⎦

⎡
⎢⎢⎢⎣

β1

β2

...
βp

⎤
⎥⎥⎥⎦+

⎡
⎢⎢⎢⎣

e1
e2
...
en

⎤
⎥⎥⎥⎦ . (2.3)

Often the first column of X is X1 = 1, the n × 1 vector of ones. The ith
case (xT

i , Yi) = (xi1, xi2, . . . , xip, Yi) corresponds to the ith row xT
i of X

and the ith element of Y (if xi1 ≡ 1, then xi1 could be omitted). In the
MLR model Y = xTβ + e, the Y and e are random variables, but we only
have observed values Yi and xi. If the ei are iid (independent and identically
distributed) with zero mean E(ei) = 0 and variance VAR(ei) = V (ei) = σ2,
then regression is used to estimate the unknown parameters β and σ2.

Definition 2.5. The constant variance MLR model uses the
assumption that the errors e1, . . . , en are iid with mean E(ei) = 0 and
variance VAR(ei) = σ2 < ∞. Also assume that the errors are independent
of the predictor variables xi. The predictor variables xi are assumed to be
fixed and measured without error. The cases (xT

i , Yi) are independent for
i = 1, . . . , n.

If the predictor variables are random variables, then the above MLR model
is conditional on the observed values of the xi. That is, observe the xi and
then act as if the observed xi are fixed.
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Definition 2.6. The unimodal MLR model has the same assumptions
as the constant variance MLR model, as well as the assumption that the zero
mean constant variance errors e1, . . . , en are iid from a unimodal distribution
that is not highly skewed. Note that E(ei) = 0 and V (ei) = σ2 < ∞.

Definition 2.7. The normal MLR model or Gaussian MLR model has
the same assumptions as the unimodal MLR model but adds the assumption
that the errors e1, . . . , en are iid N(0, σ2) random variables. That is, the ei
are iid normal random variables with zero mean and variance σ2.

The unknown coefficients for the above 3 models are usually estimated
using (ordinary) least squares (OLS).

Notation. The symbol A ≡ B = f(c) means that A and B are equivalent
and equal, and that f(c) is the formula used to compute A and B.

Definition 2.8. Given an estimate b of β, the corresponding vector of
predicted values or fitted values is Ŷ ≡ Ŷ (b) = Xb. Thus the ith fitted value

Ŷi ≡ Ŷi(b) = xT
i b = xi,1b1 + · · ·+ xi,pbp.

The vector of residuals is r ≡ r(b) = Y − Ŷ (b). Thus ith residual ri ≡
ri(b) = Yi − Ŷi(b) = Yi − xi,1b1 − · · · − xi,pbp.

Most regression methods attempt to find an estimate β̂ of β which mini-
mizes some criterion function Q(b) of the residuals.

Definition 2.9. The ordinary least squares (OLS) estimator β̂OLS mini-
mizes

QOLS(b) =

n∑
i=1

r2i (b), (2.4)

and β̂OLS = (XTX)−1XTY .

The vector of predicted or fitted values Ŷ OLS = Xβ̂OLS = HY where the
hat matrix H = X(XTX)−1XT provided the inverse exists. Typically the
subscript OLS is omitted, and the least squares regression equation is
Ŷ = β̂1x1 + β̂2x2 + · · ·+ β̂pxp where x1 ≡ 1 if the model contains a constant.

There are many statistical models besides the MLR model, and you should
learn how to quickly recognize an MLR model. A “regression” model has a
response variable Y and the conditional distribution of Y given the predic-
tors x = (x1, . . . , xp)

T is of interest. Regression models are used to predict Y
and to summarize the relationship between Y and x. If a constant xi,1 ≡ 1
(this notation means that xi,1 = 1 for i = 1, . . . , n) is in the model, then
xi,1 is often called the trivial predictor, and the MLR model is said to have
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a constant or intercept. All nonconstant predictors are called nontrivial pre-
dictors. The term “multiple” is used if the model uses one or more nontrivial
predictors. (Some authors use multivariate instead of multiple, but in this
text a multivariate linear regression model will have m ≥ 2 response vari-
ables. See Chapter 12.) The simple linear regression model is a special case
of the MLR model that uses exactly one nontrivial predictor. Suppose the
response variable is Y and data has been collected on additional variables
x1, . . . , xp.

An MLR model is “linear” in the unknown coefficients β. Thus the model
is an MLR model in Y and β if we can write Yi = xT

i β+ei or Yi = wT
i β+ei

where each wi is a function of x1, . . . , xp. Symbols other than w or x may be
used. Alternatively, the model is linear in the parameters β if ∂Y/∂βi does
not depend on the parameters. If Y = xTβ+ e = x1β1 + · · ·+xpβp + e, then
∂Y/∂βi = xi. Similarly, if Y = wTβ + e, then ∂Y/∂βi = wi.

Example 2.2. a) Suppose that interest is in predicting a function of Z
from functions of w1, . . . , wk. If Y = t(Z) = xTβ + e where t is a function
and each xi is some function of w1, . . . , wk, then there is an MLR model in
Y and β. Similarly, Z = t(Y ) = wTβ + e is an MLR model in Z and β.

b) To see that Y = β1 + β2x + β3x
2 + e is an MLR model in Y and β,

take w1 = 1, w2 = x, and w3 = x2. Then Y = wTβ + e.
c) If Y = β1 + β2 exp(β3x) + e, then the model is a nonlinear regression

model that is not an MLR model in Y and β. Notice that the model can
not be written in the form Y = wTβ + e and that ∂Y/∂β2 = exp(β3x) and
∂Y/∂β3 = β2x exp(β3x) depend on the parameters.

2.2 Checking Goodness of Fit

It is crucial to realize that an MLR model is not necessarily a
useful model for the data, even if the data set consists of a response
variable and several predictor variables. For example, a nonlinear regression
model or a much more complicated model may be needed. Chapters 1 and 13
describe several alternative models. Let p be the number of predictors and n
the number of cases. Assume that n ≥ 5p, then plots can be used to check
whether the MLR model is useful for studying the data. This technique is
known as checking the goodness of fit of the MLR model.

Notation. Plots will be used to simplify regression analysis, and in this
text a plot of W versus Z uses W on the horizontal axis and Z on the vertical
axis.

Definition 2.10. A scatterplot of X versus Y is a plot of X versus Y
and is used to visualize the conditional distribution Y |X of Y given X.
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Definition 2.11. A response plot is a plot of a variable wi versus Yi.
Typically wi is a linear combination of the predictors: wi = xT

i η where η is
a known p×1 vector. The most commonly used response plot is a plot of the
fitted values Ŷi versus the response Yi.

Proposition 2.1. Suppose that the regression estimator b of β is used to
find the residuals ri ≡ ri(b) and the fitted values Ŷi ≡ Ŷi(b) = xT

i b. Then

in the response plot of Ŷi versus Yi, the vertical deviations from the identity
line (that has unit slope and zero intercept) are the residuals ri(b).

Proof. The identity line in the response plot is Y = xT b. Hence the
vertical deviation is Yi − xT

i b = ri(b). �

Definition 2.12. A residual plot is a plot of a variable wi versus the
residuals ri. The most commonly used residual plot is a plot of Ŷi versus ri.

Notation: For MLR, “the residual plot” will often mean the residual
plot of Ŷi versus ri, and “the response plot” will often mean the plot of Ŷi

versus Yi.

If the unimodal MLR model as estimated by least squares is useful, then
in the response plot the plotted points should scatter about the identity line
while in the residual plot of Ŷ versus r the plotted points should scatter
about the r = 0 line (the horizontal axis) with no other pattern. Figures 1.2
and 1.3 show what a response plot and residual plot look like for an artificial
MLR data set where the MLR regression relationship is rather strong in that
the sample correlation corr(Ŷ , Y ) is near 1. Figure 1.4 shows a response plot
where the response Y is independent of the nontrivial predictors in the model.
Here corr(Ŷ , Y ) is near 0 but the points still scatter about the identity line.
When the MLR relationship is very weak, the response plot will look like the
residual plot.

The above ideal shapes for the response and residual plots are for when
the unimodal MLR model gives a good approximation for the data. If the
plots have the ideal shapes and n ≥ 10p, then expect inference, except for
classical prediction intervals, to be approximately correct for many unimodal
distributions that are close to the normal distribution.

If the response and residual plots suggest an MLR model with iid skewed
errors, then add lowess to both plots. The scatterplot smoother tries to esti-
mate the mean function E(Y |Ŷ ) or E(r|Ŷ ) without using any model. If the
lowess curve is close to the identity line in the response plot and close to the
r = 0 line in the residual plot, then the constant variance MLR model may be
a good approximation to the data, but sample sizes much larger than n = 10p
may be needed before inference is approximately correct. Such skewed data
sets seem rather rare, but see Chen et al. (2009) and see Problem 2.28.

Remark 2.1. For any MLR analysis, always make the response
plot and the residual plot of Ŷi versus Yi and ri, respectively.
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Fig. 2.1 Residual and Response Plots for the Tremearne Data

Definition 2.13. An outlier is an observation that lies far away from the
bulk of the data.

Remark 2.2. For MLR, the response plot is important because MLR
is the study of the conditional distribution of Y |xTβ, and the response
plot is used to visualize the conditional distribution of Y |xTβ since

Ŷ = xT β̂ is a good estimator of xTβ if β̂ is a good estimator of β.

If the MLR model is useful, then the plotted points in the response plot
should be linear and scatter about the identity line with no gross outliers.
Suppose the fitted values range in value from wL to wH with no outliers. Fix
the fit = w in this range and mentally add a narrow vertical strip centered at
w to the response plot. The plotted points in the vertical strip should have a
mean near w since they scatter about the identity line. Hence Y |fit = w is
like a sample from a distribution with mean w. The following example helps
illustrate this remark.

Example 2.3. Tremearne (1911) presents a data set of about 17 mea-
surements on 115 people of Hausa nationality. We deleted 3 cases because
of missing values and used height as the response variable Y . Along with a
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constant xi,1 ≡ 1, the five additional predictor variables used were height
when sitting, height when kneeling, head length, nasal breadth, and span (per-
haps from left hand to right hand). Figure 2.1 presents the OLS response and
residual plots for this data set. These plots show that an MLR model should
be a useful model for the data since the plotted points in the response plot
are linear and follow the identity line while the plotted points in the residual
plot follow the r = 0 line with no other pattern (except for a possible outlier
marked 44).

To use the response plot to visualize the conditional distribution of Y |xTβ,

use the fact that the fitted values Ŷ = xT β̂. For example, suppose the height
given fit = 1700 is of interest. Mentally examine the plot about a narrow
vertical strip about fit = 1700, perhaps from 1685 to 1715. The cases in the
narrow strip have a mean close to 1700 since they fall close to the identity
line. Similarly, when the fit = w for w between 1500 and 1850, the cases have
heights near w, on average.

Cases 3, 44, and 63 are highlighted. The 3rd person was very tall while
the 44th person was rather short. Beginners often label too many points as
outliers. Mentally draw a box about the bulk of the data ignoring any outliers.
Double the width of the box (about the identity line for the response plot
and about the horizontal line for the residual plot). Cases outside of this
imaginary doubled box are potential outliers. Alternatively, visually estimate
the standard deviation of the residuals in both plots. In the residual plot look
for residuals that are more than 5 standard deviations from the r = 0 line.
In Figure 2.1, the standard deviation of the residuals appears to be around
10. Hence cases 3 and 44 are certainly worth examining.

The identity line can also pass through or near an outlier or a cluster
of outliers. Then the outliers will be in the upper right or lower left of the
response plot, and there will be a large gap between the cluster of outliers
and the bulk of the data. See Figure 3.11. Figure 2.1 was made with the
following R commands, using lregpack function MLRplot and the major.lsp
data set from the text’s webpage.

major <- matrix(scan(),nrow=112,ncol=7,byrow=T)

#copy and paste the data set then press enter

major <- major[,-1]

X<-major[,-6]

Y <- major[,6]

MLRplot(X,Y) #left click the 3 highlighted cases,

#then right click Stop for each of the two plots
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2.3 Checking Lack of Fit

The response plot may look good while the residual plot suggests that the
unimodal MLR model can be improved. Examining plots to find model vio-
lations is called checking for lack of fit. Again assume that n ≥ 5p.

The unimodal MLR model often provides a useful model for the data, but
the following assumptions do need to be checked.
i) Is the MLR model appropriate?
ii) Are outliers present?
iii) Is the error variance constant or nonconstant? The constant variance
assumption VAR(ei) ≡ σ2 is known as homoscedasticity. The nonconstant
variance assumption VAR(ei) = σ2

i is known as heteroscedasticity.
iv) Are any important predictors left out of the model?
v) Are the errors e1, . . . , en iid?
vi) Are the errors ei independent of the predictors xi?

Make the response plot and the residual plot to check i), ii), and iii). An
MLR model is reasonable if the plots look like Figures 1.2, 1.3, 1.4, and 2.1.
A response plot that looks like Figure 13.7 suggests that the model is not
linear. If the plotted points in the residual plot do not scatter about the
r = 0 line with no other pattern (i.e., if the cloud of points is not ellipsoidal or
rectangular with zero slope), then the unimodal MLR model is not sustained.

The ith residual ri is an estimator of the ith error ei. The constant variance
assumption may have been violated if the variability of the point cloud in the
residual plot depends on the value of Ŷ . Often the variability of the residuals
increases as Ŷ increases, resulting in a right opening megaphone shape. (Fig-
ure 4.1b has this shape.) Often the variability of the residuals decreases as Ŷ
increases, resulting in a left opening megaphone shape. Sometimes the vari-
ability decreases then increases again, and sometimes the variability increases
then decreases again (like a stretched or compressed football).

2.3.1 Residual Plots

Remark 2.3. Residual plots magnify departures from the model while the
response plot emphasizes how well the MLR model fits the data.

Since the residuals ri = êi are estimators of the errors, the residual plot
is used to visualize the conditional distribution e|SP of the errors given the

sufficient predictor SP = xTβ, where SP is estimated by Ŷ = xT β̂. For the
unimodal MLR model, there should not be any pattern in the residual plot:
as a narrow vertical strip is moved from left to right, the behavior of the
residuals within the strip should show little change.
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Notation. A rule of thumb is a rule that often but not always works well
in practice.

Rule of thumb 2.1. If the residual plot would look good after several
points have been deleted, and if these deleted points were not gross outliers
(points far from the point cloud formed by the bulk of the data), then the
residual plot is probably good. Beginners often find too many things wrong
with a good model. For practice, use the lregpack function MLRsim to generate
several MLR data sets, and make the response and residual plots for these
data sets: type MLRsim(nruns=10) in R and right click Stop for each plot
(20 times) to generate 10 pairs of response and residual plots. This exercise
will help show that the plots can have considerable variability even when the
MLR model is good. See Problem 2.30.

Rule of thumb 2.2. If the plotted points in the residual plot look like
a left or right opening megaphone, the first model violation to check is the
assumption of nonconstant variance. (This is a rule of thumb because it is
possible that such a residual plot results from another model violation such
as nonlinearity, but nonconstant variance is much more common.)

The residual plot of Ŷ versus r should always be made. It is also a good idea
to plot each nontrivial predictor xj versus r and to plot potential predictors
wj versus r. If the predictor is quantitative, then the residual plot of xj versus

r should look like the residual plot of Ŷ versus r. If the predictor is qualitative,
e.g. gender, then interpreting the residual plot is much more difficult; however,
if each category contains many observations, then the plotted points for each
category should form a vertical line centered at r = 0 with roughly the same
variability (spread or range).

Rule of thumb 2.3. Suppose that the MLR model uses predictors xj

and that data has been collected on variables wj that are not included in
the MLR model. To check whether important predictors have been left out,
make residual plots of xj and wj versus r. If these plots scatter about the
r = 0 line with no other pattern, then there is no evidence that x2

j or wj are
needed in the model. If the plotted points scatter about a parabolic curve,
try adding x2

j or wj and w2
j to the MLR model. If the plot of the potential

predictor wj versus r has a linear trend, try adding wj to the MLR model.
The additive error regression model and EE plot in Section 13.7 can also be
used to check whether important predictors have been left out.

Rule of thumb 2.4. To check that the errors are independent of the pre-
dictors, make residual plots of xj versus r. If the plot of xj versus r scatters
about the r = 0 line with no other pattern, then there is no evidence that the
errors depend on xj . If the variability of the residuals changes with the value
of xj , e.g. if the plot resembles a left or right opening megaphone, the errors
may depend on xj . Some remedies for nonconstant variance are considered
in Chapter 4.
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To study residual plots, some notation and properties of the least squares
estimator are needed. MLR is the study of the conditional distribution of
Yi|xT

i β, and the MLR model is Y = Xβ + e where X is an n × p matrix
of full rank p. Hence the number of predictors p ≤ n. The ith row of X is
xT
i = (xi,1, . . . , xi,p) where xi,k is the value of the ith observation on the

kth predictor xk. We will denote the jth column of X by Xj ≡ vj which
corresponds to the jth variable or predictor xj .

Example 2.4. If Y is brain weight in grams, x1 ≡ 1, x2 is age, and x3 is
the size of the head in (mm)3, then for the Gladstone (1905) data

Y =

⎡
⎢⎢⎢⎣

3738
4261
...

3306

⎤
⎥⎥⎥⎦ , X =

⎡
⎢⎢⎢⎣

1 39 149.5
1 35 152.5
...

...
...

1 19 141

⎤
⎥⎥⎥⎦ = [v1 v2 v3].

Hence the first person had brain weight = 3738, age = 39, and size = 149.5.
After deleting observations with missing values, there were n = 267 cases
(people measured on brain weight, age, and size), and x267 = (1, 19, 141)T .
The second predictor x2 = age corresponds to the 2nd column of X and
is X2 = v2 = (39, 35, . . . , 19)T . Notice that X1 ≡ v1 = 1 = (1, . . . , 1)T

corresponds to the constant x1.

The results in the following proposition are properties of least squares
(OLS), not of the underlying MLR model. See Chapter 11 for more linear
model theory. Definitions 2.8 and 2.9 define the hat matrix H , vector of
fitted values Ŷ , and vector of residuals r. Parts f) and g) make residual plots
useful. If the plotted points are linear with roughly constant variance and the
correlation is zero, then the plotted points scatter about the r = 0 line with
no other pattern. If the plotted points in a residual plot of w versus r do show
a pattern such as a curve or a right opening megaphone, zero correlation will
usually force symmetry about either the r = 0 line or the w = median(w)
line. Hence departures from the ideal plot of random scatter about the r = 0
line are often easy to detect.

Warning: If n > p, as is usually the case, X is not square, so (XTX)−1 �=
X−1(XT )−1 since X−1 does not exist.

Proposition 2.2. Suppose that X is an n×p matrix of full rank p. Then
a) H is symmetric: H = HT .
b) H is idempotent: HH = H.
c) XTr = 0 so that XT

j r = vT
j r = 0.

d) If there is a constant X1 ≡ v1 = 1 in the model, then the sum of the
residuals is zero:

∑n
i=1 ri = 0.

e) rT Ŷ = 0.
f) If there is a constant in the model, then the sample correlation of the

fitted values and the residuals is 0: corr(r, Ŷ ) = 0.
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g) If there is a constant in the model, then the sample correlation of the
jth predictor with the residuals is 0: corr(r,vj) = 0 for j = 1, . . . , p.

Proof. a) XTX is symmetric since (XTX)T = XT (XT )T = XTX.
Hence (XTX)−1 is symmetric since the inverse of a symmetric matrix is
symmetric. (Recall that if A has an inverse then (AT )−1 = (A−1)T .) Thus
using (AT )T = A and (ABC)T = CTBTAT shows that

HT = XT [(XTX)−1]T (XT )T = H.

b)HH = X(XTX)−1XTX(XTX)−1XT = H since (XTX)−1XTX =
Ip, the p× p identity matrix.

c) XTr = XT (Ip −H)Y = [XT −XTX(XTX)−1XT ]Y =

[XT −XT ]Y = 0. Since vj is the jth column of X, vT
j is the jth row of XT

and vT
j r = 0 for j = 1, . . . , p.

d) Since v1 = 1, vT
1 r =

∑n
i=1 ri = 0 by c).

e) rT Ŷ = [(In −H)Y ]THY = Y T (In −H)HY = Y T (H −H)Y = 0.

f) The sample correlation between W and Z is corr(W,Z) =

∑n
i=1(wi − w)(zi − z)

(n− 1)swsz
=

∑n
i=1(wi − w)(zi − z)√∑n

i=1(wi − w)2
∑n

i=1(zi − z)2

where sm is the sample standard deviation of m for m = w, z. So the result

follows if A =
∑n

i=1(Ŷi − Ŷ )(ri − r) = 0. Now r = 0 by d), and thus

A =

n∑
i=1

Ŷiri − Ŷ

n∑
i=1

ri =

n∑
i=1

Ŷiri

by d) again. But
∑n

i=1 Ŷiri = rT Ŷ = 0 by e).

g) Following the argument in f), the result follows if A =∑n
i=1(xi,j − xj)(ri − r) = 0 where xj =

∑n
i=1 xi,j/n is the sample mean of

the jth predictor. Now r =
∑n

i=1 ri/n = 0 by d), and thus

A =

n∑
i=1

xi,jri − xj

n∑
i=1

ri =

n∑
i=1

xi,jri

by d) again. But
∑n

i=1 xi,jri = XT
j r = vT

j r = 0 by c). �



28 2 Multiple Linear Regression

2.3.2 Other Model Violations

Without loss of generality, E(e) = 0 for the unimodal MLR model with a
constant, in that if E(ẽ) = μ �= 0, then the MLR model can always be written
as Y = xTβ + e where E(e) = 0 and E(Y ) ≡ E(Y |x) = xTβ. To see this
claim notice that

Y = β̃1 + x2β2 + · · ·+ xpβp + ẽ = β̃1 + E(ẽ) + x2β2 + · · ·+ xpβp + ẽ− E(ẽ)

= β1 + x2β2 + · · ·+ xpβp + e

where β1 = β̃1 +E(ẽ) and e = ẽ−E(ẽ). For example, if the errors ẽi are iid
exponential (λ) with E(ẽi) = λ, use ei = ẽi − λ.

For least squares, it is crucial that σ2 exists. For example, if the ei are iid
Cauchy(0,1), then σ2 does not exist and the least squares estimators tend to
perform very poorly.

The performance of least squares is analogous to the performance of Y .
The sample mean Y is a very good estimator of the population mean μ if the
Yi are iid N(μ, σ2), and Y is a good estimator of μ if the sample size is large
and the Yi are iid with mean μ and variance σ2. This result follows from
the central limit theorem (CLT), but how “large is large” depends on the
underlying distribution. The n > 30 rule tends to hold for distributions that
are close to normal in that they take on many values and σ2 is not huge. Error
distributions that are highly nonnormal with tiny σ2 often need n >> 30.
For example, if Y1, . . . , Yn are iid Gamma(1/m, 1), then n > 25m may be
needed. Another example is distributions that take on one value with very
high probability, e.g. a Poisson random variable with very small variance.
Bimodal and multimodal distributions and highly skewed distributions with
large variances also need larger n. Chihara and Hesterberg (2011, p. 177)
suggest using n > 5000 for moderately skewed distributions.

There are central limit type theorems for the least squares estimators that
depend on the error distribution of the iid errors ei. See Theorems 2.8, 11.25,
and 12.7. We always assume that the ei are continuous random variables with
a probability density function. Error distributions that are close to normal
may give good results for moderate n if n ≥ 10p and n−p ≥ 30 where p is the
number of predictors. Error distributions that need large n for the CLT to
apply for e, will tend to need large n for the limit theorems for least squares
to apply (to give good approximations).

Checking whether the errors are iid is often difficult. The iid assumption is
often reasonable if measurements are taken on different objects, e.g. people.
In industry often several measurements are taken on a batch of material.
For example a batch of cement is mixed and then several small cylinders of
concrete are made from the batch. Then the cylinders are tested for strength.
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Experience from such experiments suggests that objects (e.g., cylinders) from
different batches are independent, but objects from the same batch are not
independent.

One check on independence can also be made if the time order of the
observations is known. Let r[t] be the residual where [t] is the time order of
the trial. Hence [1] was the 1st and [n] was the last trial. Plot the time order
t versus r[t] if the time order is known. Again, trends and outliers suggest
that the model could be improved. A box shaped plot with no trend suggests
that the MLR model is good. A plot similar to the Durbin Watson test plots
r[t−1] versus r[t] for t = 2, . . . , n. Linear trend suggests serial correlation while
random scatter suggests that there is no lag 1 autocorrelation. As a rule of
thumb, if the OLS slope b is computed for the plotted points, b > 0.25 gives
some evidence that there is positive correlation between r[t−1] and r[t]. Time
series plots, such as the ACF or PACF of the residuals, may be useful.

If it is assumed that the error distribution is symmetric, make a histogram
of the residuals. Check whether the histogram is roughly symmetric or clearly
skewed. If it is assumed that the errors ei are iid N(0, σ2) again check
whether the histogram is mound shaped with “short tails.” A commonly
used alternative is to make a normal probability plot of the residuals. Let
r(1) < r(2) < · · · < r(n) denote the residuals ordered from smallest to largest.
Hence r(1) is the value of the smallest residual. The normal probability plot
plots the ẽ(i) versus r(i) where the ẽ(i) are the expected values of the order
statistics from a sample of size n from an N(0, 1) distribution. (Often the ẽ(i)
are the standard normal percentiles that satisfy P (Z ≤ ẽ(i)) = (i − 0.5)/n
where Z ∼ N(0, 1).)

Rules of thumb: i) if the plotted points scatter about some straight line
in the normal probability plot, then there is no evidence against the normal
assumption. ii) if the plotted points have an “ess shape” (concave up then
concave down), then the error distribution is symmetric with lighter tails
than the normal distribution. iii) If the plot resembles a cubic function, then
the error distribution is symmetric with heavier tails than the normal distri-
bution. iv) If the plotted points look concave up (e.g. like x2 where x > 0),
then the error distribution is right skewed.

2.4 The ANOVA F Test

After fitting least squares and checking the response and residual plots to see
that an MLR model is reasonable, the next step is to check whether there is
an MLR relationship between Y and the nontrivial predictors x2, . . . , xp. If

at least one of these predictors is useful, then the OLS fitted values Ŷi should
be used. If none of the nontrivial predictors is useful, then Y will give as good
predictions as Ŷi. Here the sample mean
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Y =
1

n

n∑
i=1

Yi. (2.5)

In the definition below, SSE is the sum of squared residuals and a residual
ri = êi = “errorhat.” In the literature “errorhat” is often rather misleadingly
abbreviated as “error.”

Definition 2.14. Assume that a constant is in the MLR model.
a) The total sum of squares

SSTO =

n∑
i=1

(Yi − Y )2. (2.6)

b) The regression sum of squares

SSR =

n∑
i=1

(Ŷi − Y )2. (2.7)

c) The residual sum of squares or error sum of squares is

SSE =

n∑
i=1

(Yi − Ŷi)
2 =

n∑
i=1

r2i . (2.8)

The result in the following proposition is a property of least squares (OLS),
not of the underlying MLR model. An obvious application is that given any
two of SSTO, SSE, and SSR, the 3rd sum of squares can be found using the
formula SSTO = SSE + SSR.

Proposition 2.3. Assume that a constant is in the MLR model. Then
SSTO = SSE + SSR.

Proof.

SSTO =

n∑
i=1

(Yi − Ŷi + Ŷi − Y )2 = SSE + SSR+ 2

n∑
i=1

(Yi − Ŷi)(Ŷi − Y ).

Hence the result follows if

A ≡
n∑

i=1

ri(Ŷi − Y ) = 0.

But

A =

n∑
i=1

riŶi − Y

n∑
i=1

ri = 0

by Proposition 2.2 d) and e). �
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Definition 2.15. Assume that a constant is in the MLR model and that
SSTO �= 0. The coefficient of multiple determination

R2 = [corr(Yi, Ŷi)]
2 =

SSR

SSTO
= 1− SSE

SSTO

where corr(Yi, Ŷi) is the sample correlation of Yi and Ŷi.

Warnings: i) 0 ≤ R2 ≤ 1, but small R2 does not imply that the MLR
model is bad.

ii) If the MLR model contains a constant, then there are several equivalent
formulas for R2. If the model does not contain a constant, then R2 depends
on the software package.

iii) R2 does not have much meaning unless the response plot and residual
plot both look good.

iv) R2 tends to be too high if n is small.
v) R2 tends to be too high if there are two or more separated clusters of

data in the response plot.
vi) R2 is too high if the number of predictors p is close to n.
vii) In large samples R2 will be large (close to one) if σ2 is small compared

to the sample variance S2
Y of the response variable Y . R2 is also large if the

sample variance of Ŷ is close to S2
Y . Thus R2 is sometimes interpreted as

the proportion of the variability of Y explained by conditioning on x, but
warnings i) - v) suggest that R2 may not have much meaning.

The following 2 propositions suggest that R2 does not behave well when
many predictors that are not needed in the model are included in the model.
Such a variable is sometimes called a noise variable and the MLR model
is “fitting noise.” Proposition 2.5 appears, for example, in Cramér (1946,
pp. 414–415), and suggests that R2 should be considerably larger than p/n
if the predictors are useful. Note that if n = 10p and p ≥ 2, then under the
conditions of Proposition 2.5, E(R2) ≤ 0.1.

Proposition 2.4. Assume that a constant is in the MLR model. Adding
a variable to the MLR model does not decrease (and usually increases) R2.

Proposition 2.5. Assume that a constant β1 is in the MLR model, that
β2 = · · · = βp = 0 and that the ei are iid N(0, σ2). Hence the Yi are iid
N(β1, σ

2). Then

a) R2 follows a beta distribution: R2 ∼ beta(p−1
2 , n−p

2 ).

b)

E(R2) =
p− 1

n− 1
.

c)

VAR(R2) =
2(p− 1)(n− p)

(n− 1)2(n+ 1)
.
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Notice that each SS/n estimates the variability of some quantity. SSTO/n
≈ S2

Y , SSE/n ≈ S2
e = σ2, and SSR/n ≈ S2

Ŷ
.

Definition 2.16. Assume that a constant is in the MLR model. Asso-
ciated with each SS in Definition 2.14 is a degrees of freedom (df) and a
mean square = SS/df . For SSTO, df = n− 1 and MSTO = SSTO/(n− 1).
For SSR, df = p − 1 and MSR = SSR/(p − 1). For SSE, df = n − p and
MSE = SSE/(n− p).

Seber and Lee (2003, pp. 44–47) show that when the MLR model holds,
MSE is often a good estimator of σ2. Under regularity conditions, the MSE
is one of the best unbiased quadratic estimators of σ2. For the normal MLR
model, MSE is the uniformly minimum variance unbiased estimator of σ2.
Seber and Lee also give the following theorem that shows that the MSE is an
unbiased estimator of σ2 under very weak assumptions if the MLR model is
appropriate. From Theorem 12.7 MSE is a

√
n consistent estimator of σ2.

Theorem 2.6. If Y = Xβ+e where X is an n×p matrix of full rank p, if
the ei are independent with E(ei) = 0, and VAR(ei) = σ2, then σ̂2 = MSE
is an unbiased estimator of σ2.

The ANOVA F test tests whether any of the nontrivial predictors
x2, . . . , xp are needed in the OLS MLR model, that is, whether Yi should

be predicted by the OLS fit Ŷi = β̂1 + xi,2β̂2 + · · · + xi,pβ̂p or with the
sample mean Y . ANOVA stands for analysis of variance, and the computer
output needed to perform the test is contained in the ANOVA table. Below
is an ANOVA table given in symbols. Sometimes “Regression” is replaced by
“Model” and “Residual” by “Error.”

Summary Analysis of Variance Table

Source df SS MS F p-value
Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

Remark 2.4. Recall that for a 4 step test of hypotheses, the p–value is the
probability of getting a test statistic as extreme as the test statistic actually
observed and that Ho is rejected if the p–value < δ. As a benchmark for this
textbook, use δ = 0.05 if δ is not given. The 4th step is the nontechnical
conclusion which is crucial for presenting your results to people who are not
familiar with MLR. Replace Y and x2, . . . , xp by the actual variables used in
the MLR model. Follow Example 2.5.

Notation. The p–value ≡ pvalue given by output tends to only be cor-
rect for the normal MLR model. Hence the output is usually only giving an
estimate of the pvalue, which will often be denoted by pval. So reject H0 if
pval ≤ δ. Often
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pval− pvalue
P→ 0

(converges to 0 in probability, so pval is a consistent estimator of pvalue)
as the sample size n → ∞. See Theorem 11.25, Section 11.6, and Chang
and Olive (2010). Then the computer output pval is a good estimator of the
unknown pvalue. We will use Ho ≡ H0 and Ha ≡ HA ≡ H1.

Be able to perform the 4 step ANOVA F test of hypotheses.
i) State the hypotheses Ho: β2 = · · · = βp = 0 Ha: not Ho.
ii) Find the test statistic Fo = MSR/MSE or obtain it from output.
iii) Find the pval from output or use the F–table: pval =

P (Fp−1,n−p > Fo).

iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x2, . . . , xp. If
you fail to reject Ho, conclude that there is not an MLR relationship between
Y and the predictors x2, . . . , xp. (Or there is not enough evidence to conclude
that there is an MLR relationship between Y and the predictors.)

Example 2.5. For the Gladstone (1905) data, the response variable Y =
brain weight, x1 ≡ 1, x2 = size of head, x3 = sex, x4 = breadth of head,
x5 = circumference of head. Assume that the response and residual plots
look good and test whether at least one of the nontrivial predictors is needed
in the model using the output shown below.

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 4 5396942. 1349235. 196.24 0.0000

Residual 262 1801333. 6875.32

Solution: i) Ho: β2 = · · · = β5 = 0 Ha: not Ho
ii) Fo = 196.24 from output.
iii) The pval = 0.0 from output.
iv) The pval < δ (= 0.05 since δ was not given). So reject Ho. Hence there
is an MLR relationship between brain weight and the predictors size, sex,
breadth, and circumference.

Remark 2.5. There is a close relationship between the response plot and
the ANOVA F test. If n ≥ 10p and n − p ≥ 30 and if the plotted points
follow the identity line, typically Ho will be rejected if the identity line fits
the plotted points better than any horizontal line (in particular, the line
Y = Y ). If a horizontal line fits the plotted points about as well as the identity
line, as in Figure 1.4, this graphical diagnostic is inconclusive (sometimes the
ANOVA F test will reject Ho and sometimes fail to reject Ho), but the MLR
relationship is at best weak. In Figures 1.2 and 2.1, the ANOVA F test
should reject Ho since the identity line fits the plotted points better than
any horizontal line. Under the above conditions, a graphical ANOVA F test
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rejects Ho if the response plot is not similar to the residual plot. The graphical
test is inconclusive if the response plot looks similar to the residual plot. The
graphical test is also useful for multiple linear regression methods other than
least squares, such as M -estimators and other robust regression estimators.

Definition 2.17. An RR plot is a plot of residuals from 2 different mod-
els or fitting methods.

Remark 2.6. If the RR plot of the residuals Yi−Y versus the OLS resid-
uals ri = Yi− Ŷi shows tight clustering about the identity line, then the MLR
relationship is weak: Y fits the data about as well as the OLS fit.

Example 2.6. Cook and Weisberg (1999a, pp. 261, 371) describe a data
set where rats were injected with a dose of a drug approximately proportional
to body weight. The response Y was the fraction of the drug recovered from
the rat’s liver. The three predictors were the body weight of the rat, the dose
of the drug, and the liver weight. A constant was also used. The experimenter
expected the response to be independent of the predictors, and 19 cases
were used. However, the ANOVA F test suggested that the predictors were
important. The third case was an outlier and easily detected in the response
and residual plots (not shown). After deleting the outlier, the response and
residual plots looked ok and the following output was obtained.

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 3 0.00184396 0.000614652 0.10 0.9585

Residual 14 0.0857172 0.00612265

The 4 step ANOVA F test is
i) Ho: β2 = · · · = β4 = 0 Ha: not Ho
ii) Fo = 0.10.
iii) pval = 0.9585.
iv) The pval > δ (= 0.05 since δ was not given). So fail to reject Ho. Hence
there is not an MLR relationship between fraction of drug recovered and the
predictors body weight, dose, and liver weight. (More accurately, there is not
enough statistical evidence to conclude that there is an MLR relationship:
failing to reject Ho is not the same as accepting Ho; however, it may be a
good idea to keep the nontechnical conclusions nontechnical.)

Figure 2.2 shows the RR plot where the residuals from the full model
are plotted against Yi − Y , the residuals from the model using no nontrivial
predictors. This plot reinforces the conclusion that the response Y is inde-
pendent of the nontrivial predictors. The identity line and the OLS line from
regressing ri on Yi − Y (that is, use Ỹi = ri, a constant and x̃i,2 = Yi − Y ,
find the OLS line and then plot it) are shown as visual aids. If the OLS line
and identity line nearly coincide in that it is difficult to tell that the two lines
intersect at the origin, then the 2 sets of residuals are “close.”
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Fig. 2.2 RR Plot With Outlier Deleted, Submodel Uses Only the Trivial Predictor with
Ŷ = Y

Some assumptions are needed on the ANOVA F test. Assume that both
the response and residual plots look good. It is crucial that there are no
outliers. Then a rule of thumb is that if n − p is large, then the ANOVA
F test p–value is approximately correct. An analogy can be made with the
central limit theorem, Y is a good estimator for μ if the Yi are iid N(μ, σ2)
and also a good estimator for μ if the data are iid with mean μ and variance
σ2 if n is large enough. Also see Theorem 11.25. More on the robustness and
lack of robustness of the ANOVA F test can be found in Wilcox (2012).

If all of the xi are different (no replication) and if the number of predictors
p = n, then the OLS fit Ŷi = Yi and R2 = 1. Notice that Ho is rejected if the
statistic Fo is large. More precisely, reject Ho if

Fo > Fp−1,n−p,1−δ

where
P (F ≤ Fp−1,n−p,1−δ) = 1− δ

when F ∼ Fp−1,n−p. Since R2 increases to 1 while (n− p)/(p− 1) decreases
to 0 as p increases to n, Theorem 2.7a below implies that if p is large then
the Fo statistic may be small even if some of the predictors are very good. It
is a good idea to use n ≥ 10p or at least n ≥ 5p if possible. Theorem 11.25
can be used to show that pval is a consistent estimator of the pvalue under
reasonable conditions.
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Theorem 2.7. Assume that the MLR model has a constant β1.
a)

Fo =
MSR

MSE
=

R2

1−R2

n− p

p− 1
.

b) If the errors ei are iid N(0, σ2), and if Ho: β2 = · · · = βp = 0 is true,
then Fo has an F distribution with p− 1 numerator and n− p denominator
degrees of freedom: Fo ∼ Fp−1,n−p.

c) If the errors are iid with mean 0 and variance σ2, if the error distribution
is close to normal, and if n − p is large enough, and if Ho is true, then
Fo ≈ Fp−1,n−p in that the p-value from the software (pval) is approximately
correct.

Remark 2.7. When a constant is not contained in the model (i.e., xi,1 is
not equal to 1 for all i), then the computer output still produces an ANOVA
table with the test statistic and p–value, and nearly the same 4 step test of
hypotheses can be used. The hypotheses are now Ho: β1 = · · · = βp = 0 Ha:
not Ho, and you are testing whether or not there is an MLR relationship
between Y and x1, . . . , xp. An MLR model without a constant (no intercept)
is sometimes called a “regression through the origin.” See Section 2.10.

2.5 Prediction

This section gives estimators for predicting a future or new value Yf of
the response variable given the predictors xf , and for estimating the mean
E(Yf ) ≡ E(Yf |xf ). This mean is conditional on the values of the predictors
xf , but the conditioning is often suppressed.

Warning: All too often the MLR model seems to fit the “training data”

(Y1,x1), . . . , (Yn,xn)

well, but when new “test data” is collected, a very different MLR model is
needed to fit the new data well. In particular, the MLR model seems to fit
the data (Yi,xi) well for i = 1, . . . , n, but when the researcher tries to predict
Yf for a new vector of predictors xf , the prediction is very poor in that Ŷf is
not close to the Yf actually observed. Wait until after the MLR model
has been shown to make good predictions before claiming that the
model gives good predictions!

There are several reasons why the MLR model may not fit new data well.
i) The model building process is usually iterative. Data Z, w1, . . . , wr is col-
lected. If the model is not linear, then functions of Z are used as a potential
response variable and functions of the wi as potential predictors. After trial
and error, the functions are chosen, resulting in a final MLR model using Y
and x1, . . . , xp. Since the same data set was used during the model building
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process, biases are introduced and the MLR model fits the “training data”
better than it fits new test data. Suppose that Y , x1, . . . , xp are specified
before collecting data and that the residual and response plots from the re-
sulting MLR model look good. Then predictions from the prespecified model
will often be better for predicting new data than a model built from an iter-
ative process.

ii) If (Yf ,xf ) come from a different population than the population of
(Y1,x1), . . . , (Yn,xn), then prediction for Yf can be arbitrarily bad.

iii) Even a good MLR model may not provide good predictions for an xf

that is far from the xi (extrapolation).
iv) The MLR model may be missing important predictors (underfitting).
v) The MLR model may contain unnecessary predictors (overfitting).

Three remedies for i) are a) use previously published studies to select
an MLR model before gathering data. Unfortunately, often the population
from a published study is quite different from the population of the data
collected by the researcher. Then the MLR model from the published study
is not adequate. b) Do a trial study. Collect some data, build an MLR model
using the iterative process. Then use this model as the prespecified model and
collect data for the main part of the study. Better yet, do a trial study, specify
a model, collect more trial data, improve the specified model, and repeat until
the latest specified model works well. Unfortunately, trial studies are often
too expensive or not possible because the data is difficult to collect. c) If
the data set is large enough, use a “training set” of a random sample of k
of the n cases to build a model where 10p ≤ n/2 ≤ k ≤ 0.9n. Then use
“validation set” of the other n − k cases to confirm that the model built
with the “training set” is good. This technique may help reduce biases, but
needs n ≥ 20p. See James et al. (2013, pp. 176–178). In particular, build the
model with the training set, then check the asymptotically optimal prediction
interval (2.20), derived later in this section, on the validation set.

Definition 2.18. Consider the MLR model Y = Xβ + e and the hat
matrix H = X(XTX)−1XT . Let hi = hii be the ith diagonal element of H
for i = 1, . . . , n. Then hi is called the ith leverage and hi = xT

i (X
TX)−1xi.

Suppose new data is to be collected with predictor vector xf . Then the

leverage of xf is hf = xT
f (X

TX)−1xf . Extrapolation occurs if xf is far
from the x1, . . . ,xn.

Rule of thumb 2.5. Predictions based on extrapolation are not reliable.
A rule of thumb is that extrapolation occurs if hf > max(h1, . . . , hn). This
rule works best if the predictors are linearly related in that a plot of xi versus
xj should not have any strong nonlinearities. If there are strong nonlinearities
among the predictors, then xf could be far from the xi but still have hf <
max(h1, . . . , hn).
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Example 2.7. Consider predicting Y = weight from x = height and a
constant from data collected on men between 18 and 24 where the minimum
height was 57 and the maximum height was 79 inches. The OLS equation
was Ŷ = −167 + 4.7x. If x = 70, then Ŷ = −167 + 4.7(70) = 162 pounds.
If x = 1 inch, then Ŷ = −167 + 4.7(1) = −162.3 pounds. It is impossible
to have negative weight, but it is also impossible to find a 1 inch man. This
MLR model should not be used for x far from the interval (57, 79).

Definition 2.19. Consider the unimodal MLR model Y = xTβ+e where
E(e) = 0. Then regression function is the hyperplane

E(Y ) ≡ E(Y |x) = x1β1 + x2β2 + · · ·+ xpβp = xTβ. (2.9)

Assume OLS is used to find β̂. Then the point estimator of Yf given x = xf

is
Ŷf = xf,1β̂1 + · · ·+ xf,pβ̂p = xT

f β̂. (2.10)

The point estimator of E(Yf ) ≡ E(Yf |xf ) given x = xf is also Ŷf = xT
f β̂.

Assume that the MLR model contains a constant β1 so that x1 ≡ 1. The large
sample 100 (1 − δ)% confidence interval (CI) for E(Yf |xf ) = xT

f β = E(Ŷf )
is

Ŷf ± tn−p,1−δ/2se(Ŷf ) (2.11)

where P (T ≤ tn−p,δ) = δ if T has a t distribution with n − p degrees of

freedom. Generally se(Ŷf ) will come from output, but

se(Ŷf ) =
√

MSE hf =
√

MSE xT
f (X

TX)−1xf .

Recall the interpretation of a 100 (1 − δ)% CI for a parameter μ is that
if you collect data then form the CI, and repeat for a total of k times where
the k trials are independent from the same population, then the probability
that m of the CIs will contain μ follows a binomial(k, ρ = 1− δ) distribution.
Hence if 100 95% CIs are made, ρ = 0.95 and about 95 of the CIs will contain
μ while about 5 will not. Any given CI may (good sample) or may not (bad
sample) contain μ, but the probability of a “bad sample” is δ.

The following theorem is analogous to the central limit theorem and the
theory for the t–interval for μ based on Y and the sample standard deviation
(SD) SY . If the data Y1, . . . , Yn are iid with mean 0 and variance σ2, then Y
is asymptotically normal and the t–interval will perform well if the sample
size is large enough. The result below suggests that the OLS estimators Ŷi

and β̂ are good if the sample size is large enough. The condition maxhi → 0
in probability usually holds if the researcher picked the design matrix X or
if the xi are iid random vectors from a well-behaved population. Outliers

can cause the condition to fail. Convergence in distribution, Zn
D→ Np(0,Σ),

means the multivariate normal approximation can be used for probability
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calculations involving Zn. When p = 1, the univariate normal distribution
can be used. See Sen and Singer (1993, p. 280) for the theorem, which implies

that β̂ ≈ Np(β, σ
2(XTX)−1). See Chapter 10 for the multivariate normal

distribution.

Theorem 2.8, LS CLT (Least Squares Central Limit Theorem):
Consider the MLR model Yi = xT

i β + ei and assume that the zero mean
errors are iid with E(ei) = 0 and VAR(ei) = σ2. Also assume that
maxi(h1, . . . , hn) → 0 in probability as n → ∞ and

XTX

n
→ W−1

as n → ∞. Then the least squares (OLS) estimator β̂ satisfies

√
n(β̂ − β)

D→ Np(0, σ
2 W ). (2.12)

Equivalently,

(XTX)1/2(β̂ − β)
D→ Np(0, σ

2 Ip). (2.13)

Definition 2.20. A large sample 100(1− δ)% prediction interval (PI) has
the form [L̂n, Ûn] where P (L̂n ≤ Yf ≤ Ûn) → 1 − δ as the sample size
n → ∞. For the Gaussian MLR model, assume that the random variable Yf

is independent of Y1, . . . , Yn. Then the 100 (1− δ)% PI for Yf is

Ŷf ± tn−p,1−δ/2se(pred) (2.14)

where P (T ≤ tn−p,δ) = δ if T has a t distribution with n − p degrees of
freedom. Generally se(pred) will come from output, but

se(pred) =
√
MSE (1 + hf ).

The interpretation of a 100 (1−δ)% PI for a random variable Yf is similar
to that of a CI. Collect data, then form the PI, and repeat for a total of k
times where k trials are independent from the same population. If Yfi is the
ith random variable and PIi is the ith PI, then the probability that Yfi ∈ PIi
for m of the PIs follows a binomial(k, ρ = 1 − δ) distribution. Hence if 100
95% PIs are made, ρ = 0.95 and Yfi ∈ PIi happens about 95 times.

There are two big differences between CIs and PIs. First, the length of
the CI goes to 0 as the sample size n goes to ∞ while the length of the PI
converges to some nonzero number J , say. Secondly, the CI for E(Yf |xf )
given in Definition 2.19 tends to work well for the unimodal MLR model if
the sample size is large while the PI in Definition 2.20 is made under the
assumption that the ei are iid N(0, σ2) and may not perform well if the
normality assumption is violated.
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To see this, consider xf such that the heights Y of women between 18
and 24 is normal with a mean of 66 inches and an SD of 3 inches. A 95%
CI for E(Y |xf ) should be centered at about 66 and the length should go
to zero as n gets large. But a 95% PI needs to contain about 95% of the
heights so the PI should converge to the interval 66 ± 1.96(3). This result
follows because if Y ∼ N(66, 9) then P (Y < 66 − 1.96(3)) = P (Y > 66 +
1.96(3)) ≈ 0.025. In other words, the endpoints of the PI estimate the 97.5
and 2.5 percentiles of the normal distribution. However, the percentiles of a
parametric error distribution depend heavily on the parametric distribution
and the parametric formulas are violated if the assumed error distribution is
incorrect.

Assume that the unimodal MLR model is valid so that e is from some
distribution with 0 mean and variance σ2. Olive (2007) shows that if 1− γ is
the asymptotic coverage of the classical nominal (1− δ)100% PI (2.14), then

1− γ = P (−σz1−δ/2 < e < σz1−δ/2) ≥ 1− 1

z21−δ/2

(2.15)

where the inequality follows from Chebyshev’s inequality. Hence the asymp-
totic coverage of the nominal 95% PI is at least 73.9%. The 95% PI (2.14)
was often quite accurate in that the asymptotic coverage was close to 95% for
a wide variety of error distributions. The 99% and 90% PIs did not perform
as well.

Let ξδ be the δ percentile of the error e, i.e. P (e ≤ ξδ) = δ. Let ξ̂δ be
the sample δ percentile of the residuals. Then the results from Theorem 2.8
suggest that the residuals ri estimate the errors ei, and that the sample
percentiles of the residuals ξ̂δ estimate ξδ. For many error distributions,

E(MSE) = E

(
n∑

i=1

r2i
n− p

)
= σ2 = E

(
n∑

i=1

e2i
n

)
.

This result suggests that √
n

n− p
ri ≈ ei.

Using

an =

(
1 +

15

n

)√
n

n− p

√
(1 + hf ), (2.16)

a large sample semiparametric 100(1− δ)% PI for Yf is

[Ŷf + anξ̂δ/2, Ŷf + anξ̂1−δ/2]. (2.17)

This PI is very similar to the classical PI except that ξ̂δ is used instead of
σzδ to estimate the error percentiles ξδ. The large sample coverage 1 − γ of
this nominal 100(1− δ)% PI is asymptotically correct: 1− γ = 1− δ.
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Example 2.8. For the Buxton (1920) data suppose that the response Y
= height and the predictors were a constant, head length, nasal height, bigo-
nal breadth, and cephalic index. Five outliers were deleted leaving 82 cases.
Figure 2.3 shows a response plot of the fitted values versus the response Y
with the identity line added as a visual aid. The plot suggests that the model
is good since the plotted points scatter about the identity line in an evenly
populated band although the relationship is rather weak since the correlation
of the plotted points is not very high. The triangles represent the upper and
lower limits of the semiparametric 95% PI (2.17). For this example, 79 (or
96%) of the Yi fell within their corresponding PI while 3 Yi did not. A plot
using the classical PI (2.14) would be very similar for this data. The plot was
made with the following R commands, using the lregpack function piplot.

x <- buxx[-c(61,62,63,64,65),]

Y <- buxy[-c(61,62,63,64,65)]

piplot(x,Y)
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Fig. 2.3 95% PI Limits for Buxton Data

Given output showing β̂i and given xf , se(pred), and se(Ŷf ), Example 2.9

shows how to find Ŷf , a CI for E(Yf |xf ), and the classical PI (2.14) for Yf .
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Below is shown typical output in symbols. Sometimes “Label” is replaced by
“Predictor” and “Estimate” by “coef” or “Coefficients.”

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

Example 2.9. The Rouncefield (1995) data povc.lsp are female and
male life expectancies from n = 91 countries where 6 cases with missing GNP
were deleted. Suppose that it is desired to predict female life expectancy Y
from male life expectancy X. Suppose that if Xf = 60, then se(pred) =

2.1285, and se(Ŷf ) = 0.2241. Below is some output.

Label Estimate Std. Error t-value p-value

Constant -2.93739 1.42523 -2.061 0.0422

mlife 1.12359 0.0229362 48.988 0.0000

a) Find Ŷf if Xf = 60.

Solution: In this example, xf = (1, Xf )
T since a constant is in the output

above. Thus Ŷf = β̂1 + β̂2Xf = −2.93739 + 1.12359(60) = 64.478.

b) If Xf = 60, find a 90% confidence interval for E(Y ) ≡ E(Yf |xf ).

Solution: The CI is Ŷf ± tn−2,1−δ/2se(Ŷf ) = 64.478 ± 1.645(0.2241) =
64.478 ± 0.3686 = [64.1094, 64.8466]. To use the t–table on the last page of
Chapter 14, use the 2nd to last row marked by Z since d = df = n − 2 =
89 > 30. In the last row find CI = 90% and intersect the 90% column and
the Z row to get the value of t89,0.95 ≈ z.95 = 1.645.

c) If Xf = 60, find a 90% prediction interval for Yf .

Solution: The PI is Ŷf ± tn−2,1−δ/2se(pred) = 64.478 ± 1.645(2.1285) =
64.478± 3.5014 = [60.9766, 67.9794].

Two more PIs will be defined and then the 4 PIs (2.14), (2.17), (2.18),
and (2.20) will be compared via simulation. An asymptotically conservative
(ac) 100(1− δ)% PI has asymptotic coverage 1− γ ≥ 1− δ. We used the (ac)
100(1− δ)% PI

Ŷf ±
√

n

n− p
max(|ξ̂δ/2|, |ξ̂1−δ/2|)

√
(1 + hf ) (2.18)

which has asymptotic coverage
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1− γ = P [−max(|ξδ/2|, |ξ1−δ/2|) < e < max(|ξδ/2|, |ξ1−δ/2|)]. (2.19)

Notice that 1− δ ≤ 1−γ ≤ 1− δ/2 and 1−γ = 1− δ if the error distribution
is symmetric.

In the simulations described below, ξ̂δ will be the sample percentile for the
PIs (2.17) and (2.18). A PI is asymptotically optimal if it has the shortest
asymptotic length that gives the desired asymptotic coverage. If the error
distribution is unimodal, an asymptotically optimal PI can be created by
applying the shorth(c) estimator to the residuals where c = �n(1 − δ)
 and
�x
 is the smallest integer ≥ x, e.g., �7.7
 = 8. That is, let r(1), . . . , r(n) be the
order statistics of the residuals. Compute r(c) − r(1), r(c+1) − r(2), . . . , r(n) −
r(n−c+1). Let [r(d), r(d+c−1)] = [ξ̃δ1 , ξ̃1−δ2 ] correspond to the interval with the
smallest distance. Then the large sample asymptotically optimal 100 (1−δ)%
PI for Yf is

[Ŷf + anξ̃δ1 , Ŷf + anξ̃1−δ2 ] (2.20)

where an is given by (2.16).

Remark 2.8. We recommend using the asymptotically optimal PI (2.20)
instead of the classical PI (2.14). The lregpack function pisim can be used to
recreate the simulation described below. See Problem 2.29.

A small simulation study compares the PI lengths and coverages for sample
sizes n = 50, 100, and 1000 for several error distributions. The value n = ∞
gives the asymptotic coverages and lengths. The MLR model with E(Yi) =
1 + xi2 + · · · + xi8 was used. The vectors (x2, . . . , x8)

T were iid N7(0, I7).
The error distributions were N(0,1), t3, and exponential(1) −1. Also, a small
sensitivity study to examine the effects of changing (1 + 15/n) to (1 + k/n)
on the 99% PIs (2.17) and (2.20) was performed. For n = 50 and k between
10 and 20, the coverage increased by roughly 0.001 as k increased by 1.

Table 2.1 N(0,1) Errors.

δ n clen slen alen olen ccov scov acov ocov

0.01 50 5.860 6.172 5.191 6.448 .989 .988 .972 .990

0.01 100 5.470 5.625 5.257 5.412 .990 .988 .985 .985

0.01 1000 5.182 5.181 5.263 5.097 .992 .993 .994 .992
0.01 ∞ 5.152 5.152 5.152 5.152 .990 .990 .990 .990
0.05 50 4.379 5.167 4.290 5.111 .948 .974 .940 .968

0.05 100 4.136 4.531 4.172 4.359 .956 .970 .956 .958
0.05 1000 3.938 3.977 4.001 3.927 .952 .952 .954 .948

0.05 ∞ 3.920 3.920 3.920 3.920 .950 .950 .950 .950

0.1 50 3.642 4.445 3.658 4.193 .894 .945 .895 .929

0.1 100 3.455 3.841 3.519 3.690 .900 .930 .905 .913

0.1 1000 3.304 3.343 3.352 3.304 .901 .903 .907 .901
0.1 ∞ 3.290 3.290 3.290 3.290 .900 .900 .900 .900
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Table 2.2 t3 Errors.

δ n clen slen alen olen ccov scov acov ocov

0.01 50 9.539 12.164 11.398 13.297 .972 .978 .975 .981

0.01 100 9.114 12.202 12.747 10.621 .978 .983 .985 .978

0.01 1000 8.840 11.614 12.411 11.142 .975 .990 .992 .988
0.01 ∞ 8.924 11.681 11.681 11.681 .979 .990 .990 .990

0.05 50 7.160 8.313 7.210 8.139 .945 .956 .943 .956

0.05 100 6.874 7.326 7.030 6.834 .950 .955 .951 .945

0.05 1000 6.732 6.452 6.599 6.317 .951 .947 .950 .945
0.05 ∞ 6.790 6.365 6.365 6.365 .957 .950 .950 .950

0.1 50 5.978 6.591 5.532 6.098 .915 .935 .900 .917
0.1 100 5.696 5.756 5.223 5.274 .916 .913 .901 .900

0.1 1000 5.648 4.784 4.842 4.706 .929 .901 .904 .898
0.1 ∞ 5.698 4.707 4.707 4.707 .935 .900 .900 .900

Table 2.3 Exponential(1) −1 Errors.

δ n clen slen alen olen ccov scov acov ocov

0.01 50 5.795 6.432 6.821 6.817 .971 .987 .976 .988

0.01 100 5.427 5.907 7.525 5.377 .974 .987 .986 .985
0.01 1000 5.182 5.387 8.432 4.807 .972 .987 .992 .987

0.01 ∞ 5.152 5.293 8.597 4.605 .972 .990 .995 .990

0.05 50 4.310 5.047 5.036 4.746 .946 .971 .955 .964
0.05 100 4.100 4.381 5.189 3.840 .947 .971 .966 .955

0.05 1000 3.932 3.745 5.354 3.175 .945 .954 .972 .947
0.05 ∞ 3.920 3.664 5.378 2.996 .948 .950 .975 .950
0.1 50 3.601 4.183 3.960 3.629 .920 .945 .925 .916

0.1 100 3.429 3.557 3.959 3.047 .930 .943 .945 .913
0.1 1000 3.303 3.005 3.989 2.460 .931 .906 .951 .901

0.1 ∞ 3.290 2.944 3.991 2.303 .929 .900 .950 .900

The simulation compared coverages and lengths of the classical (2.14),
semiparametric (2.17), asymptotically conservative (2.18), and asymptoti-
cally optimal (2.20) PIs. The latter 3 intervals are asymptotically optimal
for symmetric unimodal error distributions in that they have the shortest
asymptotic length that gives the desired asymptotic coverage. The PIs (2.17)
and (2.20) also give the correct asymptotic coverage if the unimodal errors
are not symmetric, while the PI (2.18) gives higher coverage (is conserva-
tive). The simulation used 5000 runs and gave the proportion p̂ of runs
where Yf fell within the nominal 100(1 − δ)% PI. The count mp̂ has a
binomial(m = 5000, p = 1 − γn) distribution where 1 − γn converges to
the asymptotic coverage (1 − γ). The standard error for the proportion
is

√
p̂(1− p̂)/5000 = 0.0014, 0.0031, and 0.0042 for p = 0.01, 0.05 and

0.1, respectively. Hence an observed coverage p̂ ∈ (0.986, 0.994) for 99%,
p̂ ∈ (0.941, 0.959) for 95%, and p̂ ∈ (0.887, 0.913) for 90% PIs suggests that
there is no reason to doubt that the PI has the nominal coverage.
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Tables 2.1–2.3 show the results of the simulations for the 3 error distri-
butions. The letters c, s, a, and o refer to intervals (2.14), (2.17), (2.18),
and (2.20), respectively. For the normal errors, the coverages were about
right and the semiparametric interval tended to be rather long for n = 50
and 100. The classical PI asymptotic coverage 1− γ tended to be fairly close
to the nominal coverage 1 − δ for all 3 distributions and δ = 0.01, 0.05, and
0.1. The asymptotically optimal PI tended to have short length and simulated
coverage close to the nominal coverage.

2.6 The Partial F Test

Suppose that there is data on variables Z, w1, . . . , wr and that a useful MLR
model has been made using Y = t(Z), x1 ≡ 1, x2, . . . , xp where each xi is
some function of w1, . . . , wr. This useful model will be called the full model. It
is important to realize that the full model does not need to use every variable
wj that was collected. For example, variables with outliers or missing values
may not be used. Forming a useful full model is often very difficult, and it is
often not reasonable to assume that the candidate full model is good based
on a single data set, especially if the model is to be used for prediction.

Even if the full model is useful, the investigator will often be interested in
checking whether a model that uses fewer predictors will work just as well.
For example, perhaps xp is a very expensive predictor but is not needed given
that x1, . . . , xp−1 are in the model. Also a model with fewer predictors tends
to be easier to understand.

Definition 2.21. Let the full model use Y , x1 ≡ 1, x2, . . . , xp and let
the reduced model use Y , x1, xi2 , . . . , xiq where {i2, . . . , iq} ⊂ {2, . . . , p}.

The partial F test is used to test whether the reduced model is good in
that it can be used instead of the full model. It is crucial that the reduced
model be selected before looking at the data. If the reduced model is selected
after looking at output and discarding the worst variables, then the p–value
for the partial F test will be too high. For (ordinary) least squares, usually
a constant is used, and we are assuming that both the full model and the
reduced model contain a constant. The partial F test has null hypothesis
Ho : βiq+1

= · · · = βip = 0, and alternative hypothesisHA : at least one of the
βij �= 0 for j > q. The null hypothesis is equivalent to Ho: “the reduced model
is good.” Since only the full model and reduced model are being compared,
the alternative hypothesis is equivalent to HA: “the reduced model is not as
good as the full model, so use the full model,” or more simply, HA : “use the
full model.”

To perform the partial F test, fit the full model and the reduced model
and obtain the ANOVA table for each model. The quantities dfF , SSE(F)
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and MSE(F) are for the full model and the corresponding quantities from
the reduced model use an R instead of an F . Hence SSE(F) and SSE(R) are
the residual sums of squares for the full and reduced models, respectively.
Shown below is output only using symbols.

Full model

Source df SS MS Fo and p-value

Regression p− 1 SSR MSR Fo=MSR/MSE
Residual dfF = n− p SSE(F) MSE(F) for Ho:β2 = · · · = βp = 0

Reduced model

Source df SS MS Fo and p-value
Regression q − 1 SSR MSR Fo=MSR/MSE

Residual dfR = n− q SSE(R) MSE(R) for Ho: β2 = · · · = βq = 0

Be able to perform the 4 step partial F test of hypotheses. i) State
the hypotheses. Ho: the reduced model is good Ha: use the full model
ii) Find the test statistic. FR =

[
SSE(R)− SSE(F )

dfR − dfF

]
/MSE(F )

iii) Find the pval = P(FdfR−dfF ,dfF > FR). (On exams typically an F table is
used. Here dfR−dfF = p−q = number of parameters set to 0, and dfF = n−p,
while pval is the estimated p–value.)
iv) State whether you reject Ho or fail to reject Ho. Reject Ho if the pval ≤ δ
and conclude that the full model should be used. Otherwise, fail to reject Ho
and conclude that the reduced model is good.

Sometimes software has a shortcut. In particular, the R software uses the
anova command. See Problem 2.27. As an example, assume that the full
model uses x2 and x3 while the reduced model uses x2. Both models contain
a constant. Then the following commands will perform the partial F test.
(On the computer screen the second command looks more like
red < − lm(y∼x2).)

full <- lm(y~x2+x3)

red <- lm(y~x2)

anova(red,full)

For an n× 1 vector a, let

‖a‖ =
√
a21 + · · ·+ a2n =

√
aTa
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be the Euclidean norm of a. If r and rR are the vector of residuals from
the full and reduced models, respectively, notice that SSE(F ) = ‖r‖2 and
SSE(R) = ‖rR‖2.

The following proposition suggests that Ho is rejected in the partial F test
if the change in residual sum of squares SSE(R)−SSE(F ) is large compared
to SSE(F ). If the change is small, then FR is small and the test suggests
that the reduced model can be used.

Proposition 2.6. Let R2 and R2
R be the multiple coefficients of determi-

nation for the full and reduced models, respectively. Let Ŷ and Ŷ R be the
vectors of fitted values for the full and reduced models, respectively. Then
the test statistic in the partial F test is

FR =

[
SSE(R)− SSE(F )

dfR − dfF

]
/MSE(F ) =

[
‖Ŷ ‖2 − ‖Ŷ R‖2

dfR − dfF

]
/MSE(F ) =

SSE(R)− SSE(F )

SSE(F )

n− p

p− q
=

R2 −R2
R

1−R2

n− p

p− q
.

Definition 2.22. An FF plot is a plot of fitted values from 2 different
models or fitting methods.

Six plots are useful diagnostics for the partial F test: the RR plot with
the full model residuals on the vertical axis and the reduced model residuals
on the horizontal axis, the FF plot with the full model fitted values on the
vertical axis, and always make the response and residual plots for the full
and reduced models. Suppose that the full model is a useful MLR model. If
the reduced model is good, then the response plots from the full and reduced
models should be very similar, visually. Similarly, the residual plots (of the
fitted values versus the residuals) from the full and reduced models should be
very similar, visually. Finally, the correlation of the plotted points in the RR
and FF plots should be high, ≥ 0.95, say, and the plotted points in the RR
and FF plots should cluster tightly about the identity line. Add the identity
line to both the RR and FF plots as a visual aid. Also add the OLS line from
regressing r on rR to the RR plot (the OLS line is the identity line in the FF
plot). If the reduced model is good, then the OLS line should nearly coincide
with the identity line in that it should be difficult to see that the two lines
intersect at the origin, as in Figure 2.2. If the FF plot looks good but the
RR plot does not, the reduced model may be good if the main goal of the
analysis is to predict Y.
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In Chapter 3, Example 3.8 describes the Gladstone (1905) data. Let the
reduced model use a constant, (size)1/3, sex, and age. Then Figure 3.7 shows
the response and residual plots for the full and reduced models, and Figure 3.9
shows the RR and FF plots.

Example 2.10. For the Buxton (1920) data, n = 76 after 5 outliers and
6 cases with missing values are removed. Assume that the response variable
Y is height, and the explanatory variables are x2 = bigonal breadth, x3 =
cephalic index, x4 = finger to ground, x5 = head length, x6 = nasal height,
and x7 = sternal height. Suppose that the full model uses all 6 predictors plus
a constant (x1) while the reduced model uses the constant, cephalic index,
and finger to ground. Test whether the reduced model can be used instead of
the full model using the output below.

Summary Analysis of Variance Table for the Full Model

Source df SS MS F p-value

Regression 6 260467. 43411.1 87.41 0.0000

Residual 69 34267.4 496.629

Summary Analysis of Variance Table for Reduced Model

Source df SS MS F p-value

Regression 2 94110.5 47055.3 17.12 0.0000

Residual 73 200623. 2748.27

Solution: The 4 step partial F test is shown below.
i) Ho: the reduced model is good Ha: use the full model
ii)

FR =

[
SSE(R)− SSE(F )

dfR − dfF

]
/MSE(F ) =

[
200623.0− 34267.4

73− 69

]
/496.629

= 41588.9/496.629 = 83.742.
iii) pval = P (F4,69 > 83.742) = 0.00.
iv) The pval < δ (= 0.05, since δ was not given), so reject Ho. The full model
should be used instead of the reduced model. (Bigonal breadth, head length,
nasal height, and sternal height are needed in the MLR for height given that
cephalic index and finger to ground are in the model.)

Using a computer to get the pval makes sense, but for exams you may need
to use a table. In ARC, you can use the Calculate probability option from the
ARC menu, enter 83.742 as the value of the statistic, 4 and 69 as the degrees
of freedom, and select the F distribution. To use the table near the end of
Chapter 14, use the bottom row since the denominator degrees of freedom 69
> 30. Intersect with the column corresponding to k = 4 numerator degrees of
freedom. The cutoff value is 2.37. If the FR statistic was 2.37, then the pval
would be 0.05. Since 83.472 > 2.37, the pval< 0.05, and since 83.472 >> 2.37,
we can say that the pval ≈ 0.0.
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Example 2.11. Now assume that the reduced model uses the constant,
sternal height, finger to ground, and head length. Using the output below, test
whether the reduced model is good.

Summary Analysis of Variance Table for Reduced Model

Source df SS MS F p-value

Regression 3 259704. 86568. 177.93 0.0000

Residual 72 35030.1 486.528

Solution: The 4 step partial F test follows.
i) Ho: the reduced model is good Ha: use the full model
ii)

FR =

[
SSE(R)− SSE(F )

dfR − dfF

]
/MSE(F ) =

[
35030.1.0− 34267.4

72− 69

]
/496.629

= 254.2333/496.629 = 0.512.
iii) The pval = P (F3,69 > 0.512) = 0.675.
iv) The pval > δ, so reject fail to reject Ho. The reduced model is good.

To use the F table near the end of Chapter 14, use the bottom row since
the denominator degrees of freedom 69 > 30. Intersect with the column cor-
responding to k = 3 numerator degrees of freedom. The cutoff value is 2.61.
Since 0.512 < 2.61, pval > 0.05, and this is enough information to fail to
reject Ho.

Some R commands and output to do the above problem are shown below.

cyp <- matrix(scan(),nrow=76,ncol=8,byrow=T,dimnames=

list( c(), c("indx", "ht", "sternal", "finger",

"hdlen","nasal","bigonal", "cephalic")))

#copy and paste the data set cyp.lsp then press enter

cyp <- cyp[,-1]; cyp <- as.data.frame(cyp)

full <- lm(ht~.,data=cyp)

red <- lm(ht~sternal+finger+hdlen,data=cyp)

anova(red,full)

Model 1: ht ~ sternal + finger + hdlen

Model 2: ht ~ sternal + finger + hdlen + nasal

+ bigonal + cephalic

Res.Df RSS Df Sum of Sq F Pr(>F)

1 72 35030

2 69 34267 3 762.67 0.5119 0.6754

2.7 The Wald t Test

Often investigators hope to examine βk in order to determine the importance
of the predictor xk in the model; however, βk is the coefficient for xk given
that the other predictors are in the model. Hence βk depends strongly on
the other predictors in the model. Suppose that the model has an intercept:
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x1 ≡ 1. The predictor xk is highly correlated with the other predictors if the
OLS regression of xk on x1, . . . , xk−1, xk+1, . . . , xp has a high coefficient of
determination R2

k. If this is the case, then often xk is not needed in the model
given that the other predictors are in the model. If at least one R2

k is high
for k ≥ 2, then there is multicollinearity among the predictors.

As an example, suppose that Y = height, x1 ≡ 1, x2 = left leg length, and
x3 = right leg length. Then x2 should not be needed given x3 is in the model
and β2 = 0 is reasonable. Similarly β3 = 0 is reasonable. On the other hand,
if the model only contains x1 and x2, then x2 is extremely important with β2

near 2. If the model contains x1, x2, x3, x4 = height at shoulder, x5 = right
arm length, x6 = head length, and x7 = length of back, then R2

i may be high
for each i ≥ 2. Hence xi is not needed in the MLR model for Y given that
the other predictors are in the model.

Definition 2.23. The 100 (1− δ) % CI for βk is β̂k± tn−p,1−δ/2 se(β̂k). If
the degrees of freedom d = n− p ≥ 30, the N(0,1) cutoff z1−δ/2 may be used.

Know how to do the 4 step Wald t–test of hypotheses.
i) State the hypotheses Ho: βk = 0 Ha: βk �= 0.

ii) Find the test statistic to,k = β̂k/se(β̂k) or obtain it from output.
iii) Find pval from output or use the t–table: pval =

2P (tn−p < −|to,k|) = 2P (tn−p > |to,k|).

Use the normal table or the d = Z line in the t–table if the degrees of freedom
d = n− p ≥ 30. Again pval is the estimated p–value.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem.

Recall that Ho is rejected if the pval ≤ δ. As a benchmark for this textbook,
use δ = 0.05 if δ is not given. If Ho is rejected, then conclude that xk is needed
in the MLR model for Y given that the other predictors are in the model.
If you fail to reject Ho, then conclude that xk is not needed in the MLR
model for Y given that the other predictors are in the model. (Or there is
not enough evidence to conclude that xk is needed in the MLR model given
that the other predictors are in the model.) Note that xk could be a very
useful individual predictor, but may not be needed if other predictors are
added to the model. It is better to use the output to get the test statistic
and pval than to use formulas and the t–table, but exams may not give the
relevant output.

Definition 2.24. Assume that there is a constant x1 ≡ 1 in the model,
and let x(k) = (x1, . . . , xk−1, xk+1, . . . , xp)

T be the vector of predictors with
the kth predictor xk deleted. Let r(k) be the residuals from regressing Y on
x(k), that is, on all of the predictor variables except xk. Let r(xk|x(k)) denote
the residuals from regressing xk on x(k). Then an added variable plot for
xk is a plot of r(xk|x(k)) versus r(k) for k = 2, . . . , p.
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The added variable plot (also called a partial regression plot) is used to
give information about the test Ho : βk = 0. The points in the plot cluster
about a line through the origin with slope = β̂k. An interesting fact is that the
residuals from this line, i.e. the residuals from regressing r(k) on r(xk|x(k)),
are exactly the same as the usual residuals from regressing Y on x. The range
of the horizontal axis gives information about the collinearity of xk with the
other predictors. Small range implies that xk is well explained by the other
predictors. The r(xk|x(k)) represent the part of xk that is not explained by
the remaining variables while the r(k) represent the part of Y that is not
explained by the remaining variables.

An added variable plot with a clearly nonzero slope and tight clustering
about a line implies that xk is needed in the MLR for Y given that the other
predictors x2, . . . , xk−1, xk+1, . . . , xp are in the model. Slope near zero in the
added variable plot implies that xk may not be needed in the MLR for Y
given that all other predictors x2, . . . , xk−1, xk+1, . . . , xp are in the model.

If the zero line with 0 slope and 0 intercept and the OLS line are added to
the added variable plot, the variable is probably needed if it is clear that the
two lines intersect at the origin. Then the point cloud should be tilted away
from the zero line. The variable is probably not needed if the two lines nearly
coincide near the origin in that you cannot clearly tell that they intersect at
the origin.

Shown below is output only using symbols and the following example shows
how to use output to perform the Wald t–test.

Response = Y
Coefficient Estimates

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

Output for Ex. 2.12

Label Estimate Std. Error t-value p-value

Constant -7736.26 2660.36 -2.908 0.0079

x2 0.180225 0.00503871 35.768 0.0000

x3 -1.89411 2.65789 -0.713 0.4832

R Squared: 0.988, Sigma hat: 4756.08, n = 26

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 41380950140. 20690475070. 914.69 0.00

Residual 23 520265969. 22620260.
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Example 2.12. The output above was collected from 26 districts in Prus-
sia in 1843. See Hebbler (1847). The goal is to study the relationship between
Y = the number of women married to civilians in the district with the predic-
tors x2 = the population of the district, and x3 = military women = number
of women married to husbands in the military.

a) Find a 95% confidence interval for β2 corresponding to population.

The CI is β̂k ± tn−p,1−δ/2 se(β̂k). Since n = 26, df = n− p = 26− 3 = 23.
From the t–table at the end of Chapter 14, intersect the df = 23 row with
the column that is labelled by 95% in the CI row near the bottom of the
table. Then tn−p,1−δ/2 = 2.069. Using the output shows that the 95% CI is
0.180225± 2.069(0.00503871) = [0.16980, 0.19065].

b) Perform a 4 step test for Ho: β2 = 0 corresponding to population.
i) Ho: β2 = 0 HA : β2 �= 0
ii) to2 = 35.768
iii) pval = 0.0
iv) Reject Ho, the population is needed in the MLR model for the number

of women married to civilians if the number of military women is in the
model.

c) Perform a 4 step test for Ho: β3 = 0 corresponding to military women.
i) Ho: β3 = 0 HA : β3 �= 0
ii) to3 = −0.713
iii) pval = 0.4883
iv) Fail to reject Ho, the number of military women is not needed in the

MLR model for the number of women married to civilians if population is in
the model.

Figure 2.4, made with the commands shown below, shows the added vari-
able plots for x2 and x3. The plot for x2 strongly suggests that x2 is needed
in the MLR model while the plot for x3 indicates that x3 does not seem to
be very important. The slope of the OLS line in a) is 0.1802 while the slope
of the line in b) is −1.894.

source("G:/lregdata.txt")

x2 <- marry[,1]

x3 <- marry[,5]

y <- marry[,3]

#par(mfrow=c(1,2),pty="s")

#square plots look nice but have too much white space

par(mfrow=c(1,2))

resy2 <- residuals(lm(y~x3))

resx2 <- residuals(lm(x2~x3))

plot(resx2,resy2)

abline(lsfit(resx2,resy2)$coef)

title("a) Added Variable Plot for x2")

resy3 <- residuals(lm(y~x2))
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b) Added Variable Plot for x3

Fig. 2.4 Added Variable Plots for x2 and x3

resx3 <- residuals(lm(x3~x2))

plot(resx3,resy3)

abline(lsfit(resx3,resy3)$coef)

title("b) Added Variable Plot for x3")

par(mfrow=c(1,1))

If the predictor xk is categorical, e.g. gender, the added variable plot may
look like two spheres, but if the OLS line is added to the plot, it will have
slope equal to β̂k.

2.8 The OLS Criterion

The OLS estimator β̂ minimizes the OLS criterion

QOLS(η) =

n∑
i=1

r2i (η)
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Fig. 2.5 The OLS Fit Minimizes the Sum of Squared Residuals

where the residual ri(η) = Yi − xT
i η. In other words, let ri = ri(β̂) be the

OLS residuals. Then
∑n

i=1 r
2
i ≤ ∑n

i=1 r
2
i (η) for any p × 1 vector η, and the

equality holds iff η = β̂ if the n× p design matrix X is of full rank p ≤ n. In
particular, if X has full rank p, then

∑n
i=1 r

2
i <

∑n
i=1 r

2
i (β) =

∑n
i=1 e

2
i even

if the MLR model Y = Xβ + e is a good approximation to the data.

Example 2.13. When a model depends on the predictors x only through
the linear combination xTβ, then xTβ is called a sufficient predictor and
xT β̂ is called an estimated sufficient predictor (ESP). For OLS the model is
Y = xTβ+ e, and the fitted value Ŷ = ESP . To illustrate the OLS criterion
graphically, consider the Gladstone (1905) data where we used brain weight as
the response. A constant, x2 = age, x3 = sex, and x4 = (size)1/3 were used
as predictors after deleting five “infants” from the data set. In Figure 2.5a, the
OLS response plot of the OLS ESP = Ŷ versus Y is shown. The vertical devi-
ations from the identity line are the residuals, and OLS minimizes the sum of
squared residuals. If any other ESP xTη is plotted versus Y , then the vertical
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deviations from the identity line are the residuals ri(η). For this data, the OLS

estimator β̂ = (498.726,−1.597, 30.462, 0.696)T . Figure 2.5b shows the re-
sponse plot using the ESP xTη where η = (498.726,−1.597, 30.462, 0.796)T .
Hence only the coefficient for x4 was changed; however, the residuals ri(η) in
the resulting plot are much larger in magnitude on average than the residuals
in the OLS response plot. With slightly larger changes in the OLS ESP, the
resulting η will be such that the squared residuals are massive.

Proposition 2.10. The OLS estimator β̂ is the unique minimizer of the
OLS criterion if X has full rank p ≤ n.

Proof: Seber and Lee (2003, pp. 36–37). Recall that the hat matrix H =
X(XTX)−1XT and notice that (I − H)T = I − H , that (I − H)H = 0
and that HX = X. Let η be any p× 1 vector. Then

(Y −Xβ̂)T (Xβ̂ −Xη) = (Y −HY )T (HY −HXη) =

Y T (I −H)H(Y −Xη) = 0.

Thus QOLS(η) = ‖Y −Xη‖2 = ‖Y −Xβ̂ +Xβ̂ −Xη‖2 =

‖Y −Xβ̂‖2 + ‖Xβ̂ −Xη‖2 + 2(Y −Xβ̂)T (Xβ̂ −Xη).

Hence

‖Y −Xη‖2 = ‖Y −Xβ̂‖2 + ‖Xβ̂ −Xη‖2. (2.21)

So

‖Y −Xη‖2 ≥ ‖Y −Xβ̂‖2

with equality iff

X(β̂ − η) = 0

iff β̂ = η since X is full rank. �

Alternatively calculus can be used. Notice that ri(η) = Yi−xi,1η1−xi,2η2−
· · · − xi,pηp. Recall that x

T
i is the ith row of X while vj is the jth column.

Since QOLS(η) =

n∑
i=1

(Yi − xi,1η1 − xi,2η2 − · · · − xi,pηp)
2,

the jth partial derivative

∂QOLS(η)

∂ηj
= −2

n∑
i=1

xi,j(Yi−xi,1η1−xi,2η2−· · ·−xi,pηp) = −2(vj)
T (Y −Xη)
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for j = 1, . . . , p. Combining these equations into matrix form, setting the
derivative to zero and calling the solution β̂ gives

XTY −XTXβ̂ = 0,

or
XTXβ̂ = XTY . (2.22)

Equation (2.22) is known as the normal equations. If X has full rank,

then β̂ = (XTX)−1XTY . To show that β̂ is the global minimizer of the
OLS criterion, use the argument following Equation (2.21).

2.9 Two Important Special Cases

When studying a statistical model, it is often useful to try to understand
the model that contains a constant but no nontrivial predictors, then try to
understand the model with a constant and one nontrivial predictor, then the
model with a constant and two nontrivial predictors, and then the general
model with many predictors. In this text, most of the models are such that
Y is independent of x given xTβ, written

Y x|xTβ.

Then wi = xT
i β̂ is a scalar, and trying to understand the model in terms

of xT
i β̂ is about as easy as trying to understand the model in terms of one

nontrivial predictor. In particular, the response plot of xT
i β̂ versus Yi is

essential.
For MLR, the two main benefits of studying the MLR model with one

nontrivial predictor X are that the data can be plotted in a scatterplot of Xi

versus Yi and that the OLS estimators can be computed by hand with the
aid of a calculator if n is small.

2.9.1 The Location Model

The location model
Yi = μ+ ei, i = 1, . . . , n (2.23)

is a special case of the multiple linear regression model where p = 1, X = 1,
and β = β1 = μ. This model contains a constant but no nontrivial predictors.

In the location model, β̂OLS = β̂1 = μ̂ = Y . To see this, notice that
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QOLS(η) =

n∑
i=1

(Yi − η)2 and
dQOLS(η)

dη
= −2

n∑
i=1

(Yi − η).

Setting the derivative equal to 0 and calling the solution μ̂ gives
∑n

i=1 Yi = nμ̂
or μ̂ = Y . The second derivative

d2QOLS(η)

dη2
= 2n > 0,

hence μ̂ is the global minimizer.

2.9.2 Simple Linear Regression

The simple linear regression (SLR) model is

Yi = β1 + β2Xi + ei = α+ βXi + ei

where the ei are iid with E(ei) = 0 and VAR(ei) = σ2 for i = 1, . . . , n.
The Yi and ei are random variables while the Xi are treated as known
constants. The parameters β1, β2, and σ2 are unknown constants that
need to be estimated. (If the Xi are random variables, then the model is
conditional on the Xi’s provided that the errors ei are independent of the
Xi. Hence the Xi’s are still treated as constants.)

The SLR model is a special case of the MLR model with p = 2, xi,1 ≡ 1,
and xi,2 = Xi. The normal SLR model adds the assumption that the ei are
iid N(0, σ2). That is, the error distribution is normal with zero mean and
constant variance σ2. The response variable Y is the variable that you want
to predict while the predictor variable X is the variable used to predict the
response. For SLR, E(Yi) = β1 + β2Xi and the line E(Y ) = β1 + β2X is the
regression function. VAR(Yi) = σ2.

For SLR, the least squares estimators β̂1 and β̂2 minimize the least
squares criterion Q(η1, η2) =

∑n
i=1(Yi − η1 − η2Xi)

2. For a fixed η1 and η2,
Q is the sum of the squared vertical deviations from the line Y = η1 + η2X.

The least squares (OLS) line is Ŷ = β̂1 + β̂2X where the slope

β̂2 ≡ β̂ =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2

and the intercept β̂1 ≡ α̂ = Y − β̂2X.
By the chain rule,

∂Q

∂η1
= −2

n∑
i=1

(Yi − η1 − η2Xi)
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and
∂2Q

∂η21
= 2n.

Similarly,

∂Q

∂η2
= −2

n∑
i=1

Xi(Yi − η1 − η2Xi)

and
∂2Q

∂η22
= 2

n∑
i=1

X2
i .

Setting the first partial derivatives to zero and calling the solutions β̂1 and
β̂2 shows that the OLS estimators β̂1 and β̂2 satisfy the normal equations:

n∑
i=1

Yi = nβ̂1 + β̂2

n∑
i=1

Xi and

n∑
i=1

XiYi = β̂1

n∑
i=1

Xi + β̂2

n∑
i=1

X2
i .

The first equation gives β̂1 = Y − β̂2X.
There are several equivalent formulas for the slope β̂2.

β̂2 ≡ β̂ =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2
=

∑n
i=1 XiYi − 1

n (
∑n

i=1 Xi)(
∑n

i=1 Yi)∑n
i=1 X

2
i − 1

n (
∑n

i=1 Xi)2

=

∑n
i=1(Xi −X)Yi∑n
i=1(Xi −X)2

=

∑n
i=1 XiYi − nX Y∑n
i=1 X

2
i − n(X)2

= ρ̂sY /sX .

Here the sample correlation ρ̂ ≡ ρ̂(X,Y ) = corr(X,Y ) =

∑n
i=1(Xi −X)(Yi − Y )

(n− 1)sXsY
=

∑n
i=1(Xi −X)(Yi − Y )√∑n

i=1(Xi −X)2
∑n

i=1(Yi − Y )2

where the sample standard deviation

sW =

√√√√ 1

n− 1

n∑
i=1

(Wi −W )2

for W = X,Y. Notice that the term n− 1 that occurs in the denominator of
ρ̂, s2Y , and s2X can be replaced by n as long as n is used in all 3 quantities.

Also notice that the slope β̂2 =
∑n

i=1 kiYi where the constants
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ki =
Xi −X∑n

j=1(Xj −X)2
. (2.24)

2.10 The No Intercept MLR Model

The no intercept MLR model, also known as regression through the origin, is
still Y = Xβ+e, but there is no intercept in the model, soX does not contain
a column of ones 1. Hence the intercept term β1 = β1(1) is replaced by β1xi1.
Software gives output for this model if the “no intercept” or “intercept = F”
option is selected. For the no intercept model, the assumption E(e) = 0 is
important, and this assumption is rather strong.

Many of the usual MLR results still hold: β̂OLS = (XTX)−1XTY , the

vector of predicted fitted values Ŷ = Xβ̂OLS = HY where the hat matrix
H = X(XTX)−1XT provided the inverse exists, and the vector of residuals

is r = Y − Ŷ . The response plot and residual plot are made in the same way
and should be made before performing inference.

The main difference in the output is the ANOVA table. The ANOVA F
test in Section 2.4 tests Ho : β2 = · · · = βp = 0. The test in this section tests
Ho : β1 = · · · = βp = 0 ≡ Ho : β = 0. The following definition and test
follows Guttman (1982, p. 147) closely.

Definition 2.25. Assume that Y = Xβ+e where the ei are iid. Assume
that it is desired to test Ho : β = 0 versus HA : β �= 0.

a) The uncorrected total sum of squares

SST =

n∑
i=1

Y 2
i . (2.25)

b) The model sum of squares

SSM =

n∑
i=1

Ŷ 2
i . (2.26)

c) The residual sum of squares or error sum of squares is

SSE =

n∑
i=1

(Yi − Ŷi)
2 =

n∑
i=1

r2i . (2.27)

d) The degrees of freedom (df) for SSM is p, the df for SSE is n − p and
the df for SST is n. The mean squares are MSE = SSE/(n− p) and MSM =
SSM/p.

The ANOVA table given for the “no intercept” or “intercept = F” option
is below.
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Summary Analysis of Variance Table

Source df SS MS F p-value

Model p SSM MSM Fo=MSM/MSE for Ho:
Residual n-p SSE MSE β = 0

The 4 step no intercept ANOVA F test for β = 0 is below.
i) State the hypotheses Ho: β = 0, Ha: β �= 0.
ii) Find the test statistic Fo = MSM/MSE or obtain it from output.
iii) Find the pval from output or use the F–table: pval = P (Fp,n−p > Fo).
iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x1, . . . , xp. If
you fail to reject Ho, conclude that there is not an MLR relationship between
Y and the predictors x1, . . . , xp. (Or there is not enough evidence to conclude
that there is an MLR relationship between Y and the predictors.)

Warning: Several important models can be cast in the no intercept MLR
form, but often a different test than Ho : β = 0 is desired. For example, when
the generalized or weighted least squares models of Chapter 4 are transformed
into no intercept MLR form, the test of interest is Ho: β2 = · · · = βp = 0.
The one way ANOVA model of Chapter 5 is equivalent to the cell means
model, which is in no intercept MLR form, but the test of interest is Ho :
β1 = · · · = βp.

Proposition 2.11. Suppose Y = Xβ + e where X may or may not con-
tain a column of ones. Then the partial F test of Section 2.6 can be used for
inference.

Example 2.14. Consider the Gladstone (1905) data described in Exam-
ple 2.5. If the file of data sets lregdata is downloaded into R, then the ANOVA
F statistic for testing β2 = · · · = β4 = 0 can be found with the following
commands. The command lsfit adds a column of ones to x which contains
the variables size, sex, breadth, and circumference. Three of these predictor
variables are head measurements. Then the response Y is brain weight, and
the model contains a constant (intercept).

> y <- cbrainy

> x <- cbrainx[,c(11,10,3,6)]

> ls.print(lsfit(x,y))

F-statistic (df=4, 262)=196.2433

The ANOVA F test can also be found with the no intercept model by
adding a column of ones to the R matrix x and then performing the partial
F test with the full model and the reduced model that only uses the column
of ones. Notice that the “intercept=F” option needs to be used to fit both
models. The residual standard error = RSE =

√
MSE. Thus SSE = (n −

k)(RSE)2 where n− k is the denominator degrees of freedom for the F test
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and k is the numerator degrees of freedom = number of variables in the
model. The column of ones xone is counted as a variable. The last line of
output computes the partial F statistic and is again ≈ 196.24.

> xone <- 1 + 0*1:267

> x <- cbind(xone,x)

> ls.print(lsfit(x,y,intercept=F))

Residual Standard Error=82.9175

F-statistic (df=5, 262)=12551.02

Estimate Std.Err t-value Pr(>|t|)

xone 99.8495 171.6189 0.5818 0.5612

size 0.2209 0.0358 6.1733 0.0000

sex 22.5491 11.2372 2.0066 0.0458

breadth -1.2464 1.5139 -0.8233 0.4111

circum 1.0255 0.4719 2.1733 0.0307

> ls.print(lsfit(x[,1],y,intercept=F))

Residual Standard Error=164.5028

F-statistic (df=1, 266)=15744.48

Estimate Std.Err t-value Pr(>|t|)

X 1263.228 10.0674 125.477 0

((266*(164.5028)^2 - 262*(82.9175)^2)/4)/(82.9175)^2

[1] 196.2435

2.11 Summary

1) The response variable is the variable that you want to predict. The pre-
dictor variables are the variables used to predict the response variable.

2) Regression is the study of the conditional distribution Y |x.
3) The MLR model is

Yi = xi,1β1 + xi,2β2 + · · ·+ xi,pβp + ei = xT
i β + ei

for i = 1, . . . , n. Here n is the sample size and the random variable ei is the ith
error. Assume that the errors are iid with E(ei) = 0 and VAR(ei) = σ2 < ∞.
Assume that the errors are independent of the predictor variables xi. The
unimodal MLR model assumes that the ei are iid from a unimodal distribution
that is not highly skewed. Usually xi,1 ≡ 1.

4) In matrix notation, these n equations become
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Y = Xβ + e,

where Y is an n × 1 vector of dependent variables, X is an n × p matrix
of predictors, β is a p × 1 vector of unknown coefficients, and e is an n × 1
vector of unknown errors.

5) The OLS estimators are β̂OLS = (XTX)−1XTY and σ̂2 = MSE =∑n
i=1 r

2
i /(n − p). Thus σ̂ =

√
MSE. The vector of predicted or fitted values

Ŷ OLS = Xβ̂OLS = HY where the hat matrix H = X(XTX)−1XT . The

ith fitted value Ŷi = xT
i β̂. The ith residual ri = Yi − Ŷi and the vector of

residuals r = Y − Ŷ = (I −H)Y . The least squares regression equation for

a model containing a constant is Ŷ = β̂1 + β̂2x2 + · · ·+ β̂pxp.

6) Always make the response plot of Ŷ versus Y and residual plot of
Ŷ versus r for any MLR analysis. The response plot is used to visualize the
MLR model, that is, to visualize the conditional distribution of Y |xTβ. If the
unimodal MLR model of 3) is useful, then i) the plotted points in the response
plot should scatter about the identity line with no other pattern, and ii) the
plotted points in the residual plot should scatter about the r = 0 line with no
other pattern. If either i) or ii) is violated, then the unimodal MLR model is
not sustained. In other words, if the plotted points in the residual plot show
some type of dependency, e.g. increasing variance or a curved pattern, then
the multiple linear regression model may be inadequate.

7) Use xf ≤ maxhi for valid predictions.

8) If the MLR model contains a constant, then SSTO = SSE + SSR where
SSTO =

∑n
i=1(Yi−Y )2, SSR =

∑n
i=1(Ŷi−Y )2 and SSE =

∑n
i=1(Yi−Ŷi)

2 =∑n
i=1 r

2
i .

9) If the MLR model contains a constant, then R2 = [corr(Yi, Ŷi)]
2 =

SSR

SSTO
= 1− SSE

SSTO
.

Source df SS MS F p-value

Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

10) Be able to perform the 4 step ANOVA F test of hypotheses.
i) State the hypotheses Ho: β2 = · · · = βp = 0 Ha: not Ho.
ii) Find the test statistic Fo = MSR/MSE or obtain it from output.
iii) Find pval, the estimated pvalue, from output or use the F–table:
pval = P (Fp−1,n−p > Fo).
iv) State whether you reject Ho or fail to reject Ho. If Ho is rejected, conclude
that there is an MLR relationship between Y and the predictors x2, . . . , xp.
If you fail to reject Ho, conclude that there is a not an MLR relationship
between Y and the predictors x2, . . . , xp.
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11) The large sample 100 (1 − δ)% CI for E(Yf |xf ) = xT
f β = E(Ŷf ) is

Ŷf ± tn−p,1−δ/2se(Ŷf ) where P (T ≤ tn−p,δ) = δ if T has a t distribution with
n− p degrees of freedom.

12) The classical 100 (1 − δ)% PI for Yf is Ŷf ± tn−p,1−δ/2se(pred), but
should be replaced with the asymptotically optimal PI (2.20).

Full model

Source df SS MS Fo and p-value
Regression p− 1 SSR MSR Fo=MSR/MSE

Residual dfF = n− p SSE(F) MSE(F) for Ho:β2 = · · · = βp = 0

Reduced model

Source df SS MS Fo and p-value

Regression q − 1 SSR MSR Fo=MSR/MSE
Residual dfR = n− q SSE(R) MSE(R) for Ho: β2 = · · · = βq = 0

13) Be able to perform the 4 step partial F test of hypotheses. i) State
the hypotheses Ho: the reduced model is good Ha: use the full model.
ii) Find the test statistic FR =

[
SSE(R)− SSE(F )

dfR − dfF

]
/MSE(F )

iii) Find the pval = P(FdfR−dfF ,dfF > FR). (On exams typically an F table is
used. Here dfR−dfF = p−q = number of parameters set to 0, and dfF = n−p,
while pval is the estimated p–value.)
iv) State whether you reject Ho or fail to reject Ho. Reject Ho if the pval ≤ δ
and conclude that the full model should be used. Otherwise, fail to reject Ho
and conclude that the reduced model is good.

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

14) The 100 (1 − δ) % CI for βk is β̂k ± tn−p,1−δ/2 se(β̂k). If the degrees
of freedom d = n− p ≥ 30, the N(0,1) cutoff z1−δ/2 may be used.

15) The corresponding 4 step t–test of hypotheses has the following steps.
i) State the hypotheses Ho: βk = 0 Ha: βk �= 0.

ii) Find the test statistic to,k = β̂k/se(β̂k) or obtain it from output.
iii) Find the pval from output or use the t–table: pval =
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2P (tn−p < −|to,k|) = 2P (tn−p > |to,k|).

Use the normal table or the d = Z line in the t–table if the degrees of freedom
d = n− p ≥ 30.
iv) State whether you reject Ho or fail to reject Ho and give a nontechnical
sentence restating your conclusion in terms of the story problem. If Ho is
rejected, then conclude that xk is needed in the MLR model for Y given that
the other predictors are in the model. If you fail to reject Ho, then conclude
that xk is not needed in the MLR model for Y given that the other predictors
are in the model.

16) Given
∑n

i=1(Xi − X)(Yi − Y ),
∑n

i=1(Xi − X)2, X, and Y , find the

least squares line Ŷ = β̂1 + β̂2X where

β̂2 =

∑n
i=1(Xi −X)(Yi − Y )∑n

i=1(Xi −X)2

and β̂1 = Y − β̂2X.

17) Given ρ̂, sX , sY , X, and Y , find the least squares line Ŷ = β̂1 + β̂2X

where β̂2 = ρ̂sY /sX and β̂1 = Y − β̂2X.

2.12 Complements

The Least Squares Central Limit Theorem 2.8 is often a good approximation
if n ≥ 10p and the error distribution has “light tails,” i.e. the probability of
an outlier is nearly 0 and the tails go to zero at an exponential rate or faster.
For error distributions with heavier tails, much larger samples are needed,
and the assumption that the variance σ2 exists is crucial, e.g. Cauchy errors
are not allowed. Norman and Streiner (1986, p. 63) recommend n ≥ 5p.

The classical MLR prediction interval does not work well and should be re-
placed by the Olive (2007) asymptotically optimal PI (2.20). Lei and Wasser-
man (2014) provide an alternative: use the Lei et al. (2013) PI [r̃L, r̃U ] on the
residuals, then the PI for Yf is

[Ŷf + r̃L, Ŷf + r̃U ]. (2.28)

Bootstrap PIs need more theory and instead of using B = 1000 samples, use
B = max(1000, n). See Olive (2014, pp. 279–285).

For the additive error regression model Y = m(x) + e, the response plot
of Ŷ = m̂(x) vs. Y , with the identity line added as a visual aid, is used
like the MLR response plot. We want n ≥ 10 df where df is the degrees of
freedom from fitting m̂. Olive (2013a) provides PIs for this model, including
the location model. These PIs are large sample PIs provided that the sample
quantiles of the residuals are consistent estimators of the population quantiles
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of the errors. The response plot and PIs could also be used for methods
described in James et al. (2013) such as ridge regression, lasso, principal
components regression, and partial least squares. See Pelawa Watagoda and
Olive (2017) if n is not large compared to p.

In addition to large sample theory, we want the PIs to work well on a
single data set as future observations are gathered, but only have the training
data (x1, Y1), . . . , (xn, Yn). Much like k-fold cross validation for discriminant
analysis, randomly divide the data set into k = 5 groups of approximately
equal size. Compute the model from 4 groups and use the 5th group as a
validation set: compute the PI for xf = xj for each j in the 5th group.
Repeat so each of the 5 groups is used as a validation set. Compute the
proportion of times Yi was in its PI for i = 1, . . . , n as well as the average
length of the n PIs. We want the proportion near the nominal proportion
and short average length if two or more models or PIs are being considered.

Following Chapter 11, under the regularity conditions, much of the infer-
ence that is valid for the normal MLR model is approximately valid for the
unimodal MLR model when the sample size is large. For example, confidence
intervals for βi are asymptotically correct, as are t tests for βi = 0 (see Li
and Duan (1989, p. 1035)), the MSE is an estimator of σ2 by Theorems 2.6
and 2.7, and variable selection procedures perform well (see Chapter 3 and
Olive and Hawkins 2005).

Algorithms for OLS are described in Datta (1995), Dongarra et al. (1979),
and Golub and Van Loan (1989). See Harter (1974a,b, 1975a,b,c, 1976) for
a historical account of multiple linear regression. Draper (2002) provides a
bibliography of more recent references.

Cook and Weisberg (1997, 1999a: ch. 17) call a plot that emphasizes model
agreement a model checking plot. Anscombe (1961) and Anscombe and Tukey
(1963) suggested graphical methods for checking multiple linear regression
and experimental design methods that were the “state of the art” at the
time.

The rules of thumb given in this chapter for residual plots are not perfect.
Cook (1998, pp. 4–6) gives an example of a residual plot that looks like a
right opening megaphone, but the MLR assumption that was violated was
linearity, not constant variance. Ghosh (1987) gives an example where the
residual plot shows no pattern even though the constant variance assumption
is violated. Searle (1988) shows that residual plots will have parallel lines if
several cases take on each of the possible values of the response variable, e.g.
if the response is a count.

Several authors have suggested using the response plot to visualize the co-
efficient of determination R2 in multiple linear regression. See, for example,
Chambers et al. (1983, p. 280). Anderson-Sprecher (1994) provides an ex-
cellent discussion about R2. Kachigan (1982, pp. 174–177) also gives a good
explanation of R2. Also see Kv̊alseth (1985), and Freedman (1983).

Hoaglin and Welsh (1978) discuss the hat matrix H, and Brooks et al.
(1988) recommend using xf < maxhi for valid predictions. Simultaneous
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prediction intervals are given by Sadooghi-Alvandi (1990). Olive (2007) sug-
gests three large sample prediction intervals for MLR that are valid under
the unimodal MLR model. Also see Schoemoyer (1992).

Sall (1990) discusses the history of added variable plots while Darlington

(1969) provides an interesting proof that β̂ minimizes the OLS criterion.

2.12.1 Lack of Fit Tests

Label Estimate Std. Error t-value p-value

Constant β̂1 se(β̂1) to,1 for Ho: β1 = 0

x2 β̂2 se(β̂2) to,2 = β̂2/se(β̂2) for Ho: β2 = 0
...

xp β̂p se(β̂p) to,p = β̂p/se(β̂p) for Ho: βp = 0

R Squared: R2

Sigma hat:
√
MSE

Number of cases: n
Degrees of Freedom : n− p

Source df SS MS F p-value

Regression p-1 SSR MSR Fo=MSR/MSE for Ho:
Residual n-p SSE MSE β2 = · · · = βp = 0

The typical “relevant OLS output” has the form given above, but occa-
sionally software also includes output for a lack of fit test as shown below.

Source df SS MS Fo

Regression p− 1 SSR MSR Fo=MSR/MSE
Residual n− p SSE MSE
lack of fit c− p SSLF MSLF FLF = MSLF/MSPE
pure error n− c SSPE MSPE

The lack of fit test assumes that

Yi = m(xi) + ei (2.29)

where E(Yi|xi) = m(xi), m is some possibly nonlinear function, and that
the ei are iid N(0, σ2). Notice that the MLR model is the special case with
m(xi) = xT

i β. The lack of fit test needs at least one replicate: 2 or more Ys
with the same value of predictors x. Then there a c “replicate groups” with
nj observations in the jth group. Each group has the vector of predictors xj ,
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say, and at least one nj > 1. Also,
∑c

j=1 nj = n. Denote the Ys in the jth

group by Yij , and let the sample mean of the Ys in the jth group be Y j .
Then

1

nj − 1

nj∑
i=1

(Yij − Y j)
2

is an estimator of σ2 for each group with nj > 1. Let

SSPE =

c∑
j=1

nj∑
i=1

(Yij − Y j)
2.

Then MSPE = SSPE/(n − c) is an unbiased estimator of σ2 when
model (2.29) holds, regardless of the form of m. The PE in SSPE stands
for “pure error.”

Now SSLF = SSE − SSPE =
∑c

j=1 nj(Y j − Ŷj)
2. Notice that Y j is an

unbiased estimator of m(xj) while Ŷj is an estimator of m if the MLR model
is appropriate: m(xj) = xT

j β. Hence SSLF and MSLF can be very large if
the MLR model is not appropriate.

The 4 step lack of fit test is i) Ho: no evidence of MLR lack of fit, HA:
there is lack of fit for the MLR model.
ii) FLF = MSLF/MSPE.
iii) The pval = P (Fc−p,n−c > FLF ).
iv) Reject Ho if pval ≤ δ and state the HA claim that there is lack of fit.
Otherwise, fail to reject Ho and state that there is not enough evidence to
conclude that there is MLR lack of fit.

Although the lack of fit test seems clever, examining the response plot and
residual plot is a much more effective method for examining whether or not
the MLR model fits the data well provided that n ≥ 10p. A graphical version
of the lack of fit test would compute the Y j and see whether they scatter
about the identity line in the response plot. When there are no replicates,
the range of Ŷ could be divided into several narrow nonoverlapping intervals
called slices. Then the mean Y j of each slice could be computed and a step
function with step height Y j at the jth slice could be plotted. If the step
function follows the identity line, then there is no evidence of lack of fit.
However, it is easier to check whether the Yi are scattered about the identity
line. Examining the residual plot is useful because it magnifies deviations
from the identity line that may be difficult to see until the linear trend is
removed. The lack of fit test may be sensitive to the assumption that the
errors are iid N(0, σ2).

When Y x|xTβ, then the response plot of the estimated sufficient pre-

dictor (ESP) xT β̂ versus Y is used to visualize the conditional distribution of
Y |xTβ, and will often greatly outperform the corresponding lack of fit test.
When the response plot can be combined with a good lack of fit plot such as
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a residual plot, using a one number summary of lack of fit such as the test
statistic FLF makes little sense.

Nevertheless, the literature for lack of fit tests for various statistical meth-
ods is enormous. See Joglekar et al. (1989), Peña and Slate (2006), and Su
and Yang (2006) for references.

For the following homework problems, Cody and Smith (2006) is useful
for SAS, while Cook and Weisberg (1999a) is useful for Arc. Becker et al.
(1988) and Crawley (2013) are useful for R.

2.13 Problems

Problems with an asterisk * are especially important.

Output for Problem 2.1

Full Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 6 265784. 44297.4 172.14 0.0000

Residual 67 17240.9 257.327

Reduced Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 1 264621. 264621. 1035.26 0.0000

Residual 72 18403.8 255.608

2.1. Assume that the response variable Y is height, and the explanatory
variables areX2 = sternal height, X3 = cephalic index, X4 = finger to ground,
X5 = head length, X6 = nasal height, and X7 = bigonal breadth. Suppose that
the full model uses all 6 predictors plus a constant (= X1) while the reduced
model uses the constant and sternal height. Test whether the reduced model
can be used instead of the full model using the output above. The data set
had 74 cases.

Output for Problem 2.2

Full Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 9 16771.7 1863.52 1479148.9 0.0000

Residual 235 0.29607 0.00126

Reduced Model Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 16771.7 8385.85 6734072.0 0.0000

Residual 242 0.301359 0.0012453
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Coefficient Estimates, Response = y, Terms = (x2 x2^2)

Label Estimate Std. Error t-value p-value

Constant 958.470 5.88584 162.843 0.0000

x2 -1335.39 11.1656 -119.599 0.0000

x2^2 421.881 5.29434 79.685 0.0000

2.2. The above output, starting on the previous page, comes from the
Johnson (1996) STATLIB data set bodyfat after several outliers are deleted.
It is believed that Y = β1+β2X2+β3X

2
2 +e where Y is the person’s bodyfat

and X2 is the person’s density. Measurements on 245 people were taken. In
addition to X2 and X2

2 , 7 additional measurements X4, . . . , X10 were taken.
Both the full and reduced models contain a constant X1 ≡ 1.

a) Predict Y if X2 = 1.04. (Use the reduced model Y = β1 + β2X2 +
β3X

2
2 + e.)

b) Test whether the reduced model can be used instead of the full model.

Output for Problem 2.3

Label Estimate Std. Error t-value p-value

Constant -5.07459 1.85124 -2.741 0.0076

log[H] 1.12399 0.498937 2.253 0.0270

log[S] 0.573167 0.116455 4.922 0.0000

R Squared: 0.895655 Sigma hat: 0.223658, n = 82

(log[H] log[S]) (4 5)

Prediction = 2.2872, s(pred) = 0.467664,

Estimated population mean value = 2.287, s = 0.410715

2.3. The above output was produced from the file mussels.lsp in Arc. See
Cook and Weisberg (1999a). Let Y = log(M) where M is the muscle mass
of a mussel. Let X1 ≡ 1, X2 = log(H) where H is the height of the shell,
and let X3 = log(S) where S is the shell mass. Suppose that it is desired to
predict Yf if log(H) = 4 and log(S) = 5, so that xT

f = (1, 4, 5). Assume that

se(Ŷf ) = 0.410715 and that se(pred) = 0.467664.

a) If xT
f = (1, 4, 5) find a 99% confidence interval for E(Yf ).

b) If xT
f = (1, 4, 5) find a 99% prediction interval for Yf .

Problem 2.4 Output, Coef. Estimates Response = height

Label Estimate Std. Error t-value p-value

Constant 227.351 65.1732 3.488 0.0008

sternal height 0.955973 0.0515390 18.549 0.0000

finger to ground 0.197429 0.0889004 2.221 0.0295
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R Squared: 0.879324 Sigma hat: 22.0731

Summary Analysis of Variance Table

Source df SS MS F p-value

Regression 2 259167. 129583. 265.96 0.0000

Residual 73 35567.2 487.222

2.4. The above output, starting on the previous page, is from the multiple
linear regression of the response Y = height on the two nontrivial predictors
sternal height = height at shoulder, and finger to ground = distance from the
tip of a person’s middle finger to the ground.

a) Consider the plot with Yi on the vertical axis and the least squares
fitted values Ŷi on the horizontal axis. Sketch how this plot should look if the
multiple linear regression model is appropriate.

b) Sketch how the residual plot should look if the residuals ri are on the
vertical axis and the fitted values Ŷi are on the horizontal axis.

c) From the output, are sternal height and finger to ground useful for
predicting height? (Perform the ANOVA F test.)

2.5. Suppose that it is desired to predict the weight of the brain (in
grams) from the cephalic index measurement. The output below uses data
from 267 people.

predictor coef Std. Error t-value p-value

Constant 865.001 274.252 3.154 0.0018

cephalic 5.05961 3.48212 1.453 0.1474

Do a 4 step test for β2 �= 0.

2.6. Suppose that the scatterplot of X versus Y is strongly curved rather
than ellipsoidal. Should you use simple linear regression to predict Y from
X? Explain.

2.7. Suppose that the 95% confidence interval for β2 is [−17.457, 15.832].
In the simple linear regression model, is X a useful linear predictor for Y ? If
your answer is no, could X be a useful predictor for Y ? Explain.

2.8. Suppose it is desired to predict the yearly return from the stock
market from the return in January. Assume that the correlation ρ̂ = 0.496.
Using the table below, find the least squares line Ŷ = β̂1 + β̂2X.

variable mean X or Y standard deviation s
January return 1.75 5.36
yearly return 9.07 15.35
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2.9. Suppose that
∑

(Xi −X)(Yi − Y ) = 70690.0,∑
(Xi −X)2 = 19800.0, X = 70.0, and Y = 312.28.

a) Find the least squares slope β̂2.

b) Find the least squares intercept β̂1.

c) Predict Y if X = 80.

xi yi xi − x yi − y (xi − x)(yi − y) (xi − x)2

38 41

56 63

59 70

64 72

74 84

2.10. In the above table, xi is the length of the femur and yi is the length
of the humerus taken from five dinosaur fossils (Archaeopteryx) that preserved
both bones. See Moore (2000, p. 99).

a) Complete the table and find the least squares estimators β̂1 and β̂2.

b) Predict the humerus length if the femur length is 60.

2.11. Suppose that the regression model is Yi = 7 + βXi + ei for i =
1, . . . , n where the ei are iid N(0, σ2) random variables. The least squares

criterion is Q(η) =
n∑

i=1

(Yi − 7− ηXi)
2.

a) What is E(Yi)?

b) Find the least squares estimator β̂ of β by setting the first derivative
d

dη
Q(η) equal to zero.

c) Show that your β̂ is the global minimizer of the least squares criterion

Q by showing that the second derivative
d2

dη2
Q(η) > 0 for all values of η.

2.12. The location model is Yi = μ+ei for i = 1, . . . , n where the ei are iid
with mean E(ei) = 0 and constant variance VAR(ei) = σ2. The least squares

estimator μ̂ of μ minimizes the least squares criterion Q(η) =

n∑
i=1

(Yi − η)2.

To find the least squares estimator, perform the following steps.
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a) Find the derivative
d

dη
Q, set the derivative equal to zero and solve for

η. Call the solution μ̂.

b) To show that the solution was indeed the global minimizer of Q, show

that
d2

dη2
Q > 0 for all real η. (Then the solution μ̂ is a local min and Q is

convex, so μ̂ is the global min.)

2.13. The normal error model for simple linear regression through the
origin is

Yi = βXi + ei

for i = 1, . . . , n where e1, . . . , en are iid N(0, σ2) random variables.

a) Show that the least squares estimator for β is

β̂ =

∑n
i=1 XiYi∑n
i=1 X

2
i

.

b) Find E(β̂).

c) Find VAR(β̂).

(Hint: Note that β̂ =
∑n

i=1 kiYi where the ki depend on the Xi which are
treated as constants.)

2.14. Suppose that the regression model is Yi = 10+2Xi2+β3Xi3+ei for
i = 1, . . . , n where the ei are iid N(0, σ2) random variables. The least squares

criterion is Q(η3) =

n∑
i=1

(Yi − 10− 2Xi2 − η3Xi3)
2. Find the least squares es-

timator β̂3 of β3 by setting the first derivative
d

dη3
Q(η3) equal to zero. Show

that your β̂3 is the global minimizer of the least squares criterion Q by show-

ing that the second derivative
d2

dη23
Q(η3) > 0 for all values of η3.

Minitab Problems
“Double click” means press the rightmost “mouse” button twice in rapid

succession. “Drag” means hold the mouse button down. This technique is
used to select “menu” options.

After your computer is on, get into Minitab, often by searching programs
and then double clicking on the icon marked “Student Minitab.”
i) In a few seconds, the Minitab session and worksheet windows fill the screen.
At the top of the screen there is a menu. The upper left corner has the menu
option “File.” Move your cursor to “File” and drag down the option “Open
Worksheet.” A window will appear. Double click on the icon “Student.” This
will display a large number of data sets.
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ii) In the middle of the screen there is a “scroll bar,” a gray line with left and
right arrow keys. Use the right arrow key to make the data file “ Prof.mtw”
appear. Double click on “Prof.mtw.” A window will appear. Click on “OK.”
iii) The worksheet window will now be filled with data. The top of the screen
has a menu. Go to “Stat” and drag down “Regression.” Another window will
appear: drag down Regression (write this as Stat>Regression>Regression).
iv) A window will appear with variables to the left and the response variable
and predictors (explanatory variables) to the right. Double click on “instru-
crs” to make it the response. Double click on “manner” to make it the (pre-
dictor) explanatory variable. Then click on “OK.”
v) The required output will appear in the session window. You can view the
output by using the vertical scroll bar on the right of the screen.
vi) Copy and paste the output into Word, or to print your single page of
output, go to “File,” and drag down the option “Print Session Window.” A
window will appear. Click on “ok.” Then get your output from the printer.

Use the F3 key to clear entries from a dialog window if you make a mistake
or want a new plot.

To get out of Minitab, move your cursor to the “x” in the upper right
corner of the screen. When asked whether to save changes, click on “no.”

2.15. (Minitab problem.) See the above instructions for using Minitab.
Get the data set prof.mtw. Assign the response variable to be instrucr (the
instructor rating from course evaluations) and the explanatory variable (pre-
dictor) to be manner (the manner of the instructor). Run a regression on
these variables.

a) Place the computer output into Word.

b) Write the regression equation.

c) Predict instrucr if manner = 2.47.

d) To get residual and response plots you need to store the residuals and
fitted values. Use the menu commands “Stat>Regression>Regression” to get
the regression window. Put instrucr in the Response and manner in the
Predictors boxes. The click on Storage. From the resulting window click
on Fits and Residuals. Then click on OK twice.

To get a response plot, use the commands “Graph>Plot,” (double click)
place instrucr in the Y box, and Fits1 in the X box. Then click on OK. Print
the plot by clicking on the graph and then clicking on the printer icon.

e) To make a residual plot, use the menu commands “Graph>Plot” to get
a window. Place “Resi1” in the Y box and “Fits1” in the X box. Then click
on OK. Print the plot by clicking on the graph and then clicking on the
printer icon.
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2.16. a) Enter the following data on the Minitab worksheet:

x y

30 73

20 50

60 128

80 170

40 87

50 108

60 135

30 60

70 148

60 132

To enter the data click on theC1 column header and enter x. Then click on
the C2 header and enter y. Then enter the data. Or copy the data from Prob-
lem 2.17 obtained from (http://lagrange.math.siu.edu/Olive/lreghw.
txt).
Then in Minitab, use the menu commands “Edit>Paste Cells” and click on
“OK.” Obtain the regression output from Minitab with the menu commands
“Stat>Regression>Regression.”

b) Place the output into Word.

c) Write down the least squares equation.

To save your output on your flash drive (J, say), use the Word menu
commands “File > Save as.” In the Save in box select “Removable Disk
(J:),” and in the “File name box” enter HW2d16.doc. To get a Word printout,
click on the printer icon or use the menu commands “File>Print.”

d) To get residual and response plots you need to store the residuals and
fitted values. Use the menu commands “Stat>Regression>Regression” to get
the regression window. Put Y in the Response and X in the Predictors
boxes. The click on Storage. From the resulting window click on Fits and
Residuals. Then click on OK twice.

To make a response plot, use the menu commands “Graph>Plot” to get
a window. Place “Y” in the Y box and “Fits1” in the X box. Then click on
OK. Print the plot by clicking on the graph and then clicking on the printer
icon.

e) To make a residual plot of the fitted values versus the residuals, use
the menu commands “Graph>Plot” to get a window. Place “Resi1” in the Y
box and “Fits1” in the X box. Then click on OK. Print the plot by clicking
on the graph and then clicking on the printer icon.

f) To save your Minitab data on your flash drive, use the menu commands
“File>Save Current Worksheet as.” In the resulting dialog window, the top
box says Save in and there is an arrow icon to the right of the top box.
Click several times on the arrow icon until the Save in box reads “My com-

http://lagrange.math.siu.edu/Olive/lreghw.txt
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puter,” then click on “Removable Disk (J:).” In the File name box, enter
H2d16.mtw. Then click on OK.

SAS Problems

Copy and paste the SAS programs for problems 2.17 and 2.18
from (http://lagrange.math.siu.edu/Olive/lreghw.txt), or enter
the SAS program in Notepad or Word.

SAS is a statistical software package widely used in industry. You will need
a flash dive. Referring to the program for Problem 2.17, the semicolon “;”
is used to end SAS commands and the “options ls = 70;” command makes
the output readable. (An “*” can be used to insert comments into the SAS
program. Try putting an * before the options command and see what it does
to the output.) The next step is to get the data into SAS. The command “data
wcdata;” gives the name “wcdata” to the data set. The command “input x
y;” says the first entry is variable x and the 2nd variable y. The command
“cards;” means that the data is entered below. Then the data is entered
and the isolated semicolon indicates that the last case has been entered. The
command “proc print;” prints out the data. The command “proc corr;” will
give the correlation between x and y. The commands “proc plot; plot y*x;”
makes a scatterplot of x and y. The commands “proc reg; model y=x; output
out = a p =pred r =resid;” tells SAS to perform a simple linear regression
with y as the response variable. The output data set is called “a” and contains
the fitted values and residuals. The command “proc plot data = a;” tells SAS
to make plots from data set “a” rather than data set “wcdata.” The command
“plot resid*(pred x);” will make a residual plot of the fitted values versus the
residuals and a residual plot of x versus the residuals. The next plot command
makes a response plot.

To use SAS on windows (PC), use the following steps.

i) Get into SAS, often by double clicking on an icon for programs such as a
“Math Progs” icon and then double clicking on a SAS icon. If your computer
does not have SAS, go to another computer.

ii) A window should appear with 3 icons. Double click on The SAS System
for . . . .

iii) Like Minitab, a window with a split screen will open. The top screen
says Log-(Untitled) while the bottom screen says Editor-Untitled1. Press the
spacebar and an asterisk appears: Editor-Untitled1*.

2.17. a) Copy and paste the program for this problem from
(http://lagrange.math.siu.edu/Olive/lreghw.txt), or enter the SAS
program in Notepad or Word. The ls stands for linesize so l is a lowercase L,
not the number one.

When you are done entering the program, you may want to save the pro-
gram as h2d17.sas on your flash drive (J: drive, say). (On the top menu of
the editor, use the commands “File > Save as.” A window will appear. Use

http://lagrange.math.siu.edu/Olive/lreghw.txt
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the upper right arrow to locate “Removable Disk (J:)” and then type the file
name in the bottom box. Click on OK.)

b) Get back into SAS, and from the top menu, use the “File> Open”
command. A window will open. Use the arrow in the upper right corner
of the window to navigate to “Removable Disk (J:).” (As you click on the
arrow, you should see My Documents, C: etc, then Removable Disk (J:).)
Double click on h2d17.sas. (Alternatively cut and paste the program into the
SAS editor window.) To execute the program, use the top menu commands
“Run>Submit.” An output window will appear if successful.

If you were not successful, look at the log window for hints on errors.
A single typo can cause failure. Reopen your file in Word or Notepad and
make corrections. Occasionally you cannot find your error. Then find your
instructor or wait a few hours and reenter the program.

c) To copy and paste relevant output into Word or Notepad, click on the
output window and use the top menu commands “Edit>Select All” and then
the menu commands “Edit>Copy.”

In Notepad use the commands “Edit>Paste.” Then use the mouse to high-
light the relevant output. Then use the commands “Edit>Copy.”

Finally, in Word, use the command “Paste.” You can also cut output from
Word and paste it into Notepad.

You may want to save your SAS output as the file HW2d17.doc on your
flash drive.

d) To save your output on your flash drive, use the Word menu commands
“File > Save as.” In the Save in box select “Removable Disk (J:)” and in
the “File name box” enter HW2d17.doc. To get a Word printout, click on the
printer icon or use the menu commands “File>Print.”

Save the output giving the least squares coefficients in Word.

e) Predict Y if X = 40.

f) What is the residual when X = 40?

2.18. This problem shows how to use SAS for MLR. The data are from
Kutner et al. (2005, problem 6.5). The response is “brand liking,” a measure-
ment for whether the consumer liked the brand. The variable X1 is “moisture
content” and the variable X2 is “sweetness.” Copy and paste the program for
this problem from (http://lagrange.math.siu.edu/Olive/lreghw.txt).

a) Execute the SAS program and copy the output file into Notepad. Scroll
down the output that is now in Notepad until you find the regression coeffi-
cients and ANOVA table. Then cut and paste this output into Word.

b) Do the 4 step ANOVA F test.

You should scroll through your SAS output to see how it made the re-
sponse plot and various residual plots, but cutting and pasting these plots is

http://lagrange.math.siu.edu/Olive/lreghw.txt
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tedious. So we will use Minitab to get these plots. Find the program for this
problem from (http://lagrange.math.siu.edu/Olive/lreghw.txt). Then
copy and paste the numbers (between “cards;” and the semicolon “;”) into
Minitab. Use the mouse commands “Edit>Paste Cells.” This should enter
the data in the Worksheet (bottom part of Minitab). Under C1 enter Y and
under C2 enter X1 under C3 enter X2. Use the menu commands
“Stat>Regression>Regression” to get a dialog window. Enter Y as the re-
sponse variable and X1 and X2 as the predictor variable. Click on Storage
then on Fits, Residuals, and OK OK.

c) To make a response plot, enter the menu commands “Graph>Plot”
and place “Y” in the Y–box and “FITS1” in the X–box. Click on OK. Then
use the commands “Edit>Copy Graph” to copy the plot. Include the plot in
Word with the commands “Edit> Paste.” If these commands fail, click on
the graph and then click on the printer icon.

d) Based on the response plot, does a linear model seem reasonable?

e) To make a residual plot, enter the menu commands “Graph>Plot” and
place “RESI 1” in the Y–box and “FITS1” in the X–box. Click on OK. Then
use the commands “Edit>Copy Graph” to copy the plot. Include the plot in
Word with the commands “Edit> Paste.” If these commands fail, click on
the graph and then click on the printer icon.

f) Based on the residual plot does a linear model seem reasonable?

Problems using ARC

To quit Arc, move the cursor to the x in the upper right corner and click.
Warning: Some of the following problems uses data from the

book’s webpage (http://lagrange.math.siu.edu/Olive/lregbk.htm).
Save the data files on a flash drive G, say. Get in Arc and use the menu
commands “File > Load” and a window with a Look in box will appear. Click
on the black triangle and then on Removable Disk (G:). Then click twice on
the data set name.

2.19∗. (Scatterplot in Arc.) Get cbrain.lsp as described above. (Activate
the cbrain.lsp dataset with the menu commands “File > Load > Removable
Disk (G:) > cbrain.lsp.”) Scroll up the screen to read the data description.

a) Make a plot of age versus brain weight brnweight. The commands
“Graph&Fit > Plot of” will bring down a menu. Put age in the H box
and brnweight in the V box. Put sex in the Mark by box. Click OK. Make
the lowess bar on the plot read .1. Open Word.

In Arc, use the menu commands “Edit > Copy.” In Word, use the menu
command “Paste.” This should copy the graph into the Word document.

b) For a given age, which gender tends to have larger brains?

c) At what age does the brain weight appear to be decreasing?

http://lagrange.math.siu.edu/Olive/lreghw.txt
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2.20. (SLR in Arc.) Activate cbrain.lsp as in Problem 2.19. Brain weight
and the cube root of size should be linearly related. To add the cube root of
size to the data set, use the menu commands “cbrain > Transform.” From
the window, select size and enter 1/3 in the p: box. Then click OK. Get some
output with commands “Graph&Fit > Fit linear LS.” In the dialog window,
put brnweight in Response, and (size)1/3 in terms.

a) Cut and paste the output (from Coefficient Estimates to Sigma hat)

into Word. Write down the least squares equation Ŷ = β̂1 + β̂2x.

b) If (size)1/3 = 15, what is the estimated brnweight?

c) Make a residual plot of the fitted values versus the residuals. Use
the commands “Graph&Fit > Plot of” and put “L1:Fit-values” in H and
“L1:Residuals” in V. Put sex in the Mark by box. Move the OLS bar to 1.
Put the plot into Word. Does the plot look ellipsoidal with zero mean?

d) Make a response plot of the fitted values versus Y = brnweight. Use
the commands “Graph&Fit > Plot of” and put “L1:Fit-values in H and
brnweight in V. Put sex in Mark by. Move the OLS bar to 1. Put the plot
into Word. Does the plot look linear?

2.21. In Arc enter the menu commands “File>Load>Data” and open the
file mussels.lsp. This data set is from Cook and Weisberg (1999a).

The response variable Y is the mussel muscle mass M, and the explanatory
variables are X2 = S = shell mass, X3 = H = shell height, X4 = L = shell
length, and X5 = W = shell width.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter S, H, L, W in the “Terms/Predictors” box, M in the “Response” box
and click on OK.

a) To get a response plot, enter the menu commands
“Graph&Fit>Plot of” and place L1:Fit-Values in the H–box and M in the
V–box. Copy the plot into Word.

b) Based on the response plot, does a linear model seem reasonable?

c) To get a residual plot, enter the menu commands “Graph&Fit>Plot of”
and place L1:Fit-Values in the H–box and L1:Residuals in the V–box. Copy
the plot into Word.

d) Based on the residual plot, what MLR assumption seems to be violated?

e) Include the regression output in Word.
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f) Ignoring the fact that an important MLR assumption seems to have
been violated, do any of predictors seem to be needed given that the other
predictors are in the model?

g) Ignoring the fact that an important MLR assumption seems to have
been violated, perform the ANOVA F test.

2.22. Get cyp.lsp as described above Problem 2.19. You can open the
file in Notepad and then save it on a flash drive G, say, using the Notepad
menu commands “File>Save As” and clicking the top checklist then click
“Removable Disk (G:).” You could also save the file on the desktop, load it
in Arc from the desktop, and then delete the file (sending it to the Recycle
Bin).

a) In Arc enter the menu commands “File>Load>Removable Disk (G:)”
and open the file cyp.lsp. This data set consists of various measurements
taken on men from Cyprus around 1920. Let the response Y = height and
X = cephalic index = 100(head breadth)/(head length). Use Arc to get the
least squares output and include the relevant output in Word.

b) Intuitively, the cephalic index should not be a good predictor for a
person’s height. Perform a 4 step test of hypotheses with Ho: β2 = 0.

2.23. a) In Arc open the file cyp.lsp (obtained as in Problem 2.22).

The response variable Y is height, and the explanatory variables are a
constant, X2 = sternal height (probably height at shoulder), and X3 = finger
to ground.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter sternal height and finger to ground in the “Terms/Predictors” box,
height in the “Response” box and click on OK.

Include the output in Word. Your output should certainly include the lines
from “Response = height” to the ANOVA table.

b) Predict Y if X2 = 1400 and X3 = 650.

c) Perform a 4 step ANOVA F test of the hypotheses with
Ho: β2 = β3 = 0.

d) Find a 99% CI for β2.

e) Find a 99% CI for β3.

f) Perform a 4 step test for β2 = 0.

g) Perform a 4 step test for β3 = 0.

h) What happens to the conclusion in g) if δ = 0.01?
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i) The Arc menu “L1” should have been created for the regression. Use
the menu commands “L1>Prediction” to open a dialog window. Enter 1400
650 in the box and click on OK. Include the resulting output in Word.

j) Let Xf,2 = 1400 and Xf,3 = 650 and use the output from i) to find a

95% CI for E(Yf ). Use the last line of the output, that is, se = S(Ŷf ).

k) Use the output from i) to find a 95% PI for Yf . Now se(pred) = s(pred).

2.24. In Arc enter the menu commands “File>Load>Removable Disk
(G:)” and open the file cyp.lsp (obtained as in Problem 2.22).

The response variable Y is height, and the explanatory variables are
X2 = sternal height (probably height at shoulder), and X3 = finger to ground.

Enter the menu commands “Graph&Fit>Fit linear LS” and fit the model:
enter sternal height and finger to ground in the “Terms/Predictors” box,
height in the “Response” box and click on OK.

a) To get a response plot, enter the menu commands
“Graph&Fit>Plot of” and place L1:Fit-Values in the H–box and height in
the V–box. Copy the plot into Word.

b) Based on the response plot, does a linear model seem reasonable?

c) To get a residual plot, enter the menu commands “Graph&Fit>Plot of”
and place L1:Fit-Values in the H–box and L1:Residuals in the V–box. Copy
the plot into Word.

d) Based on the residual plot, does a linear model seem reasonable?

2.25. In Arc enter the menu commands “File>Load>Removable Disk
(G:)” and open the file cyp.lsp (obtained as in Problem 2.22).

The response variable Y is height, and the explanatory variables are X2 =
sternal height, X3 = finger to ground, X4 = bigonal breadth, X5 = cephalic
index, X6 = head length, and X7 = nasal height. Enter the menu commands
“Graph&Fit>Fit linear LS” and fit the model: enter the 6 predictors (in
order: X2 1st and X7 last) in the “Terms/Predictors” box, height in the
“Response” box and click on OK. This gives the full model. For the reduced
model, only use predictors 2 and 3.

a) Include the ANOVA tables for the full and reduced models in Word.

b) Use the menu commands “Graph&Fit>Plot of. . . ” to get a dialog win-
dow. Place L2:Fit-Values in the H–box and L1:Fit-Values in the V–box. Place
the resulting plot in Word.
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c) Use the menu commands “Graph&Fit>Plot of. . . ” to get a dialog win-
dow. Place L2:Residuals in the H–box and L1:Residuals in the V–box. Place
the resulting plot in Word.

d) Both plots should cluster tightly about the identity line if the reduced
model is about as good as the full model. Is the reduced model good?

e) Perform the 4 step partial F test (of Ho: the reduced model is good)
using the 2 ANOVA tables from part a).

2.26. a) Activate the cbrain.lsp data set in ARC. Fit least squares with
age, sex, size1/3, and headht as terms and brnweight as the response. See
Problem 2.20. Assume that the multiple linear regression model is appro-
priate. (This may be a reasonable assumption, 5 infants appear as outliers
but the data set has hardly any cases that are babies. If age was uniformly
represented, the babies might not be outliers anymore.) Assuming that ARC
makes the menu “L1” for this regression, select “AVP-All 2D.” A window will
appear. Move the OLS slider bar to 1 and click on the “zero line box.” The
window will show the added variable plots for age, sex, size1/3, and headht
as you move along the slider bar that is below “case deletions.” Include all 4
added variable plots in Word.

b) What information do the 4 plots give? For example, which variables do
not seem to be needed?

(If it is clear that the zero and OLS lines intersect at the origin, then the
variable is probably needed, and the point cloud should be tilted away from
the zero line. If it is difficult to see where the two lines intersect since they
nearly coincide near the origin, then the variable may not be needed, and the
point cloud may not tilt away from the zero line.)

R Problems

Use the command source(“G:/lregpack.txt”) to download the func-
tions and the command source(“G:/lregdata.txt”) to download the data.
See Preface or Section 14.1. Typing the name of the lregpack function,
e.g. piplot, will display the code for the function. Use the args command,
e.g. args(pisim), to display the needed arguments for the function. For some
of the following problems, the R commands can be copied and pasted from
(http://lagrange.math.siu.edu/Olive/lreghw.txt) into R.

2.27. a) Download the data into R as described above.
For the Buxton (1920) data suppose that the response Y = height and the

predictors were a constant, head length, nasal height, bigonal breadth, and
cephalic index. There are 87 cases.

Type the following commands

zbux <- cbind(buxx,buxy)

zbux <- as.data.frame(zbux)

zfull <- lm(buxy~len+nasal+bigonal+cephalic,data=zbux)

http://lagrange.math.siu.edu/Olive/lreghw.txt
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zred <- lm(buxy~len+nasal,data=zbux)

anova(zred,zfull)

b) Include the output in Word: press the Ctrl and c keys as the same
time. Then use the menu commands “Paste” in Word (or copy and paste the
output: hit the Ctrl and v keys at the same time).

c) Use the output to perform the partial F test where the full model is
described in a) and the reduced model uses a constant, head length, and
nasal height. The output from the anova(zred,zfull) command produces
the correct partial F statistic.

d) Use the following commands to make the response plot for the reduced
model. Include the plot in Word.

plot(zred$fit,buxy)

abline(0,1)

e) Use the following command to make the residual plot for the reduced
model. Include the plot in Word.

plot(zred$fit,zred$resid)

f) The plots look bad because of 5 massive outliers. The following com-
mands remove the outliers. Include the output in Word.

zbux <- zbux[-c(60,61,62,63,64,65),]

zfull <- lm(buxy~len+nasal+bigonal+cephalic,data=zbux)

zred <- lm(buxy~len+nasal,data=zbux)

anova(zred,zfull)

g) Redo the partial F test.
h) Use the following commands to make the response plot for the reduced

model without the outliers. Include the plot in Word.

plot(zred$fit,zbux[,5])

abline(0,1)

i) Use the following command to make the residual plot for the reduced
model without the outliers. Include the plot in Word.

plot(zred$fit,zred$resid)

j) Do the plots look ok?

2.28. Get the R commands for this problem. The data is such that Y =
2 + x2 + x3 + x4 + e where the zero mean errors are iid [exponential(2) -
2]. Hence the residual and response plots should show high skew. Note that
β = (2, 1, 1, 1)T . The R code uses 3 nontrivial predictors and a constant, and
the sample size n = 1000.
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a) Copy and paste the commands for part a) of this problem into R. Include
the response plot in Word. Is the lowess curve fairly close to the identity line?

b) Copy and paste the commands for part b) of this problem into R.
Include the residual plot in Word: press the Ctrl and c keys as the same time.
Then use the menu command “Paste” in Word. Is the lowess curve fairly
close to the r = 0 line?

c) The output out$coef gives β̂. Write down β̂. Is β̂ close to β?

2.29. a) Download the R functions piplot and pisim from lregpack.

b) The command pisim(n=100, type = 1) will produce the mean length
of the classical, semiparametric, asymptotically conservative, and asymptot-
ically optimal PIs when the errors are normal, as well as the coverage pro-
portions. Give the simulated lengths and coverages. Note: pimenlen gives the
four lengths (classical, semi, ac, aopt). Make table with headers classical,
semi, ac, and aopt.

c) Repeat b) using the command pisim(n=100, type = 3). Now the er-
rors are EXP(1) - 1.

d) Download lregdata.txt and type the command
piplot(cbrainx,cbrainy). This command gives the semiparametric PI lim-
its for the Gladstone data. Include the plot in Word.

e) The infants are in the lower left corner of the plot. Do the PIs seem to
be better for the infants or the bulk of the data. Explain briefly.

2.30. Use the function MLRsim as described in Rule of Thumb 2.1 to
generate 10 pairs of response and residual plots. Right click Stop twenty
times, and include the last plot in Word.
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